


 

 

RAPID 3D SCENE RECONSTRUCTION FROM KITE-BASED AERIAL IMAGERY 

USING OPEN SOURCE STRUCTURE FROM MOTION 

A Thesis Project submitted in partial fulfillment of the requirements for the degree of 

Masters of Science at George Mason University 

by 

Michael Roy Resig 

Bachelor of Arts 

Wheaton College, IL 2009 

Director: Arie Croitoru, Professor 

Department of Geoinformatics and Geospatial Intelligence 

Fall Semester 2014 

George Mason University 

Fairfax, VA 



ii 

 

 
THIS WORK IS LICENSED UNDER A CREATIVE COMMONS  

ATTRIBUTION-NODERIVS 3.0 UNPORTED LICENSE. 

 

http://creativecommons.org/licenses/by-nd/3.0/
http://creativecommons.org/licenses/by-nd/3.0/


iii 

 

DEDICATION 

This is dedicated to my loving and wonderful wife Hannah. Your continual support has 

motivated me throughout the years to keep chasing my passions and enjoy life. Also to 

my family, who always taught me to pursue my interests with vigor and integrity and 

supported me every step of the journey. 



iv 

 

ACKNOWLEDGEMENTS 

I would like to thank the many friends, coworkers, and supporters who have helped make 

my degree and thesis possible. Without them, I would not have had the opportunity to 

pursue this degree. Dr. Matt Rice, Dr. Arie Croitoru, and Dr. Anthony Stefanidis were 

pivotal in guiding and educating me during my Master program. Finally, I would like to 

thank my past professors and mentors for guiding me to where I am today. Their 

dedication to education and excellence gave me the tools to excel at life and learning. 

 



v 

 

TABLE OF CONTENTS 

Page 

List of Tables .................................................................................................................... vii 

List of Figures .................................................................................................................. viii 

List of Abbreviations ......................................................................................................... ix 

Abstract ............................................................................................................................... x 

Chapter One: Introduction .................................................................................................. 1 

1.1 Motivation ................................................................................................................. 1 

1.2 Problem Definition .................................................................................................... 2 

1.3 Thesis Objectives ...................................................................................................... 3 

1.4 Thesis Organization................................................................................................... 4 

Chapter Two: Related work ................................................................................................ 6 

2.1 Relevant Fields .......................................................................................................... 6 

2.2 Overall Methodology ................................................................................................ 9 

2.3 Aerial Systems and Imagery ................................................................................... 11 

2.4 Structure from Motion ............................................................................................. 12 

2.5 3D Reconstruction ................................................................................................... 13 

Chapter Three: Method Application ................................................................................. 16 

3.1 Overview ................................................................................................................. 16 

3.1.1 Location ............................................................................................................ 18 

3.1.2 Schedule............................................................................................................ 20 

3.1.3 Process Workflow............................................................................................. 23 

3.2 Data Capture ............................................................................................................ 24 

3.2.1 Equipment ......................................................................................................... 24 

3.2.2 Setup and Planning ........................................................................................... 28 

3.2.3 Capture Procedure ............................................................................................ 31 

3.2.4 Upload and Conversion .................................................................................... 33 

3.3 Structure from Motion ............................................................................................. 34 

file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497382
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497383
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497384
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497385
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497386
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497387
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497388
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497389
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497390
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497391
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497392
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497393
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497394
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497395
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497396
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497397
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497398
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497399
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497400
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497401
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497402
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497403
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497404
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497405
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497406
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497407


vi 

 

3.3.1 Equipment ......................................................................................................... 34 

3.3.2 Setup and Preparation ....................................................................................... 35 

3.3.3 SfM Algorithm ................................................................................................. 38 

3.3.4 Point Cloud Export ........................................................................................... 44 

3.4 3D Reconstruction ................................................................................................... 45 

3.4.1 Equipment ......................................................................................................... 46 

3.4.2 Setup and Planning ........................................................................................... 47 

3.4.3 Algorithm Application ...................................................................................... 51 

3.4.4 Texture Application .......................................................................................... 54 

Chapter Four: Results ....................................................................................................... 56 

4.1 Overview ................................................................................................................. 56 

4.2 Data ......................................................................................................................... 58 

4.3 Structure from Motion ............................................................................................. 61 

4.4 3D Reconstruction ................................................................................................... 65 

4.5 Accuracy Comparison ............................................................................................. 69 

4.6 Concept Applications .............................................................................................. 73 

Chapter Five: Conclusion & Future Research .................................................................. 78 

Appendix A ....................................................................................................................... 90 

Appendix B ....................................................................................................................... 91 

References ......................................................................................................................... 92 

 

file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497408
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497409
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497410
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497411
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497412
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497413
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497414
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497415
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497416
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497417
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497418
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497419
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497420
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497421
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497422
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497423
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497424
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497425
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497426
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497427


vii 

 

LIST OF TABLES 

Table Page 

Table 1 - Workflow time................................................................................................... 56 
Table 2 - Project Costs ...................................................................................................... 58 

Table 3 - Data Table ......................................................................................................... 61 
Table 4 - Output datasets .................................................................................................. 71 

 

file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497428
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497429
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497430
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497431


viii 

 

LIST OF FIGURES 

Figure Page 

Figure 1 - Study Site: Green Acres Center facility and surrounding area ........................ 19 
Figure 2 - Simple Workflow ............................................................................................. 23 

Figure 3 - Complex Workflow .......................................................................................... 24 
Figure 4 - Aerial platform: Delta performance kite .......................................................... 25 

Figure 5 - GoPro Hero 3 Black Edition ............................................................................ 27 
Figure 6 - GoPro wireless directory .................................................................................. 31 
Figure 7 - VisualSfM Toolbar ........................................................................................... 36 
Figure 8 - Step A ............................................................................................................... 37 

Figure 9 – Image thumbnails and Log .............................................................................. 38 
Figure 10 - VisualSfM: SIFT example ............................................................................. 39 

Figure 11 - Step B ............................................................................................................. 40 
Figure 12 - Step C ............................................................................................................. 41 
Figure 13 – Step C: VisualSfM Sparse Reconstruction .................................................... 42 

Figure 14 - Step D ............................................................................................................. 43 
Figure 15 - Dense point cloud ........................................................................................... 44 

Figure 16 - MeshLab Toolbar ........................................................................................... 47 
Figure 17 - MeshLab UI ................................................................................................... 48 

Figure 18 - MeshLab: Dense point cloud ......................................................................... 50 
Figure 19 - MeshLab Poisson's parameters ...................................................................... 51 

Figure 20 - Poisson results ................................................................................................ 52 
Figure 21 - MeshLab Parameterization ............................................................................. 53 

Figure 22 - MeshLab Project Texture ............................................................................... 54 
Figure 23 - Final Model with Texture............................................................................... 55 
Figure 24 - Camera view from 70 feet altitude ................................................................. 60 
Figure 25 - Results: Step A ............................................................................................... 62 
Figure 26 - Results: Spanning tree and Match matrix ...................................................... 63 

Figure 27 - Results: Step C ............................................................................................... 64 

Figure 28 - Results: Dense Point Cloud ............................................................................ 65 

Figure 29 - Results: Dense Point Cloud 2 ......................................................................... 66 
Figure 30 - Results: Steps H, I .......................................................................................... 67 
Figure 31 - Step J: Textures .............................................................................................. 68 
Figure 32 - Georeferencing Model ................................................................................... 70 
Figure 33 - 500 ft kite altitude .......................................................................................... 83 

 

file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497432
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497433
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497434
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497435
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497436
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497437
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497438
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497439
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497440
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497441
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497442
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497443
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497444
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497445
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497446
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497447
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497448
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497449
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497450
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497451
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497452
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497453
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497454
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497455
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497456
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497457
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497458
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497459
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497460
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497461
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497462
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497463
file:///C:/Users/Mike/Desktop/Resig_Thesis_12042014.docx%23_Toc405497464


ix 

 

LIST OF ABBREVIATIONS 

Three-dimensional ............................................................................................................ 3D 

User Interface .................................................................................................................... UI 

Area of Interest .............................................................................................................. AOI 

Geographic Information System ..................................................................................... GIS 

Digital Elevation Model ................................................................................................ DEM 

Global Positioning System ............................................................................................. GPS 

Root Mean Square......................................................................................................... RMS 

Structure from Motion ................................................................................................... SfM 

Scale Invariant Feature Transform................................................................................ SIFT 

Clustering Views for Multi-view Stereo .................................................................... CMVS 

 



x 

 

ABSTRACT 

RAPID 3D SCENE RECONSTRUCTION FROM KITE-BASED AERIAL IMAGERY 

USING OPEN SOURCE STRUCTURE FROM MOTION 

Michael Roy Resig, M.S. 

George Mason University, 2014 

Thesis Project Director: Dr. Arie Croitoru 

 

There has been a significant increase over the past decade in worldwide demand for rapid 

and efficient capturing of 3D geospatial data. Until recently the technology and training 

essential to acquire 3D geospatial data was severely limited to government agencies or 

large corporations. Increasingly affordable tools and methods have given 3D geospatial 

capabilities to the public, which can be observed within numerous fields of research and 

industry, such as: military operations, emergency response, humanitarian aid, municipal 

upkeep, topographic surveying, and cultural heritage. With applicable 3D data the ability 

to visualize surroundings, perform simulations, conduct crucial research, and gain 

invaluable knowledge becomes possible. This thesis focuses on developing an accessible, 

affordable workflow for rapidly creating 3D scenes constructed from captured image 

series by an aerial platform. By using open source software and simple to operate aerial 



xi 

 

vehicles such as kites, this workflow is able to be used in nearly any application while 

requiring minimal training and funding. 
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CHAPTER ONE: INTRODUCTION 

1.1 Motivation 
The adoption and implementation of 3D geospatial data by almost all major industries 

has significantly increased the demand for the ability to quickly and efficiently capture, 

create, and visualize 3D environments in an economical manner [1]. With applicable 3D 

data the ability to visualize surroundings, perform simulations, conduct crucial research, 

and gain invaluable knowledge becomes possible. A few applications of 3D environment 

data that are prominent within industries are: military operations, humanitarian response, 

and municipal upkeep. For military operations knowledge of the battlefield or 

transportation route is essential for troop safety. Using aerial sensors and imagery, 

detailed 3D reconstructions are created at nearly real-time rates to provide critical 

intelligence for squads and commanders. Applications such as viewshed and line-of-site 

allow informed decisions to be made for deploying and moving troops. During 

humanitarian response operations, using 3D reconstructions of the region in distress can 

allow precise zones to be targeted for airdrops or ground relief while taking into account 

the surrounding terrain, structures, potential hazards, and open clearings for bivouacs. 

Local governments and municipal organizations constantly monitor and zone their 

jurisdictions. Using 3D reconstructions of the neighborhood allow educated planning and 

zoning decisions by considering the surroundings. Local real estate is also able to use 3D 
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scenarios to model the environment of a single plot or an entire neighborhood, further 

enlightening buyers, sellers, or municipal regulations. 

 

1.2 Problem Definition 
Most individuals and research teams do not have the time, ability, or financial means to 

acquire high-quality 3D data that pertain to their specific needs, aside from purchasing 

3D data from large corporations and companies such as Google [2]. For example, a 

university’s cultural heritage expedition would substantially benefit from a 3D 

reconstruction of their historical site-of-interest, but they cannot acquire the proper 

equipment or even training to use the necessary tools. 3D scanning capable equipment 

that is often used by larger industries which includes laser scanners, drones, and LiDAR 

systems, can dramatically range in price and operational training, which severely limits 

access. In response to the limitations of cost and expertise with acquiring commercial 3D 

geospatial data, simpler techniques of acquisition have developed focusing on using more 

cost and time efficient methods. One of the most recent advances in cost and time 

efficient 3D geospatial data utilizes structure-from-motion (SfM) to create data for 

potential 3D environments. SfM has been used within computer science for over a decade 

and its potential applications to 3D reconstruction have been widely researched. Due to 

computationally heavy algorithms, SfM witnessed restricted use on most commercial 

computers through the 2000’s. SfM has only recently been introduced to the public 

domain in the form of media exploration applications, such as Microsoft’s Photosynth 
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and AutoDesk’s 123D. With the resurgence of SfM as an accessible method of 3D 

reconstruction there are numerous opportunities to explore its geospatial application. 

A significant geospatial application for SfM is to utilize live-feed aerial imagery 

and additional 3D meshing techniques to produce near real-time 3D reconstructions of an 

environment. Most affordable forms of aerial imaging, such as balloon and kite mapping, 

do not use streaming or wireless capabilities with photo capture equipment. In addition, 

the post-processing of the aerial imagery is usually performed in a lab space hours or 

days after the imagery capturing occurred. By improving the workflow using current 

technologies and algorithms the process of data acquisition, aerial imagery processing 

(SfM), and 3D reconstruction could be fully automated and produce near real-time visual 

results. 

 

1.3 Thesis Objectives 
The advancement of cost and time efficient 3D mapping capabilities is a growing field of 

research within geospatial sciences. The issue of costly hardware and steep operational 

training curves with 3D mapping devices severely limit the accessibility of 3D data to 

many industries and applications. The goal of this research is to demonstrate a concept 

for a time and cost efficient method for capturing high resolution aerial imagery and 

producing rapid 3D data using aerial vehicles (kite) that are cheap and simple to operate. 

The ability to produce real-time 3D environments using SfM from aerial imagery at a 

time and cost efficient level has yet to develop within the geospatial sciences. SfM has 

been robustly researched within the fields of computer science, mathematics, and 
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engineering, but using SfM with aerial imagery to reconstruct 3D environments has not 

received sufficient research publication using recent technological advances. In addition, 

the process of rapid real-time 3D reconstruction from cost efficient aerial imagery has not 

been seriously approached as a research topic. This topic is now a viable concept due to 

recent advances in photo capturing, data transmission, and computing power. Utilizing 

compact, high-quality, Wi-Fi capable camera equipment with computationally powerful 

laptops allows for rapid transfer of imagery directly to the platform that processes SfM 

and 3D reconstruction. This research question will test current SfM methods of 3D data 

acquisition by applying additional processes, using advanced equipment, incorporating 

developed algorithms, and integrating supplemental data to produce a rapid real-time 3D 

environment allowing for speedy validation and utilization. 

 

1.4 Thesis Organization 
The thesis is organized in the following manner. Chapter 2 explores and reviews related 

work. The related work addressed in this thesis pertains to each individual step within the 

analyses as well as overall approach to the problem. Chapter 3 elaborates the specific 

methods utilized within the thesis. Each sub section within the chapter focuses on a 

specific step in the overall process and the methods applied to accomplish the tasks. 

Chapter 4 presents and discusses the results generated throughout the method application. 

The data, variables, and sequential output from each step is presented and validated for 

accuracy and significance. Chapter 5 provides a conclusive overview of the thesis process 
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and results. Future applications and research are also addressed relating to the findings 

presented in chapter 4. 



6 

 

CHAPTER TWO: RELATED WORK 

The literature encompassing the thesis research topic spans several disciplines, but relate 

directly to the geospatial sciences. The procedures to be used in the working 

demonstration are gathered from the research fields of computer vision, 3D modeling, 

intelligence systems, emergency response, cultural heritage, and others. A brief review of 

related literature reveals promising utilization of successful research methods performed 

by the applicable fields. The first section (2.1) in this chapter establishes a broad 

foundation detailing the various fields that use elements of aerial imaging, SfM, or 3D 

model reconstruction. The second section (2.2) reviews related work recently performed 

and/or published that support the overall methodology and application pursued in this 

thesis. The remaining three sections (2.3, 2.4, 2.5) review related work recently 

performed and/or published that specifically pertain to the technical methods applied in 

this thesis: aerial imagery capture, structure from motion analysis, and 3D reconstruction. 

 

2.1 Relevant Fields 
The significant increase in worldwide demand for rapid and efficient capturing of 3D 

geospatial data has grown drastically in the past decade [1]. Affordable tools and methods 

have given these capabilities to a much larger population and the effects can be seen 

within numerous fields of research and industry [3]. With applicable 3D data the ability 



7 

 

to visualize surroundings, perform simulations, conduct crucial research, and gain 

invaluable knowledge becomes possible. Fields with relevant application concerning this 

thesis are: military operations, emergency response, humanitarian aid, municipal upkeep, 

topographic surveying, and cultural heritage [3]. 

For military operations knowledge of the battlefield or transportation routing is 

essential for troop safety. Using aerial sensors and imagery, incredibly detailed 3D 

reconstructions are created at nearly real-time rates to provide critical intelligence for 

squads and commanders. Applications such as viewshed and line-of-site allow informed 

decisions to be made for deploying and moving troops. Areas of research advancement 

within military application have been optimal path computation [4], real time object 

detection [5], UAV mission planning [6], and rapid 3D environment creation [7].  

Emergency response is the most time-critical civilian application of aerial 

imaging and 3D scene construction. All information produced for emergency response 

must be produced rapidly and be of utmost accuracy [3]. Applications using drones for 

overall situational awareness have been deployed for fire response [8]. The necessities of 

emergency response have driven research concerning the use of low-cost UAV platforms 

[8], real-time object detection [5], and rapid 3D modeling[7]. 

During humanitarian response operations, using 3D reconstructions of the region 

in distress can allow precise zones to be targeted for airdrops or ground relief while 

taking into account the surrounding terrain, structures, potential hazards, and open 

clearings for bivouacs [9]. It is unfortunately a common situation that areas in need of 

humanitarian need do not have sufficient geospatial resources to aid the response [10]. 
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Due to the broad demands of humanitarian response and significant data collection, 

research has advanced rapid object detection [7], and education and distribution of 

geospatial results [11].  

Local governments and municipal organizations constantly monitor and zone their 

jurisdictions. The use of aerial imaging and 3D models have become common and 

reliable tools for municipal improvements. UAVs have been used to monitor traffic, 

increasing the effectiveness of municipal implementation [12]. Using 3D reconstructions 

of the neighborhood allow educated planning and zoning decisions by considering the 

surroundings [13][14]. Effects of impervious materials on the surrounding ecosystem 

have been researched by utilizing aerial imagery and object detection [15]. Local real 

estate is also able to use 3D scenarios to model the environment of a single plot or an 

entire neighborhood, further enlightening buyers, sellers, or municipal regulations [16]. 

Topographic surveying is a broad application for aerial imagery and 3D modeling 

and has a far-reaching effect on many people. Advancements in capture technology have 

vastly improved the accessibility and distribution of topographic survey results. High 

resolution digital elevation models can be easily created using aerial imagery capture and 

SfM integration [17]. The overall accuracy of current and past topographic surveys have 

been assessed using UAV and satellite imagery integration [18]. Large-scale scene 

reconstruction and surveying is also becoming a viable method of geospatial data 

accumulation [19]. 

The fields of cultural heritage and archaeology have greatly benefitted from the 

increased accessibility of aerial imagery and 3D reconstruction technologies [20]. The 
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ability to digitally capture environments and objects for permanent record or analysis has 

expanded the research possibilities within cultural heritage to beyond field work. A 

significant advancement developed by archaeologists has appeared with the 3D 

reconstruction of historical and excavation sites using UAV and SfM technologies [2] 

[21]. Using related techniques, researchers are able to perform non-invasive surveys of 

entire regions or specific sites [22]. Having a digital record of historical sites ensures that 

the visual and cultural details of the environment will always be available for future 

research [11]. Also, the concept of “virtual museums” has now become a viable reality 

with the capability to digitally reconstruct entire landscapes and objects viewable to the 

public [23]. Perhaps the most significant development to emerge from this technological 

revolution is the expansion of archaeology outside of the exclusively academic realm 

[24]. 

 

2.2 Overall Methodology 
There are two prominent applications for the related literature: developing research 

process and workflow, and integrating technical methodology. The overall workflow 

presented in this thesis is originally developed, but greatly enhanced and inspired by 

related research. This section looks at the related work performed and published that 

support the overall methodology and application. The articles by Ducke [2], Lewis [8], 

Tonkin [17], and current research project by Dr. Block-Berlitz [21] in Germany called 

“Archaeocopter”, present excellent examples of end-to-end research projects that focus 

on demonstrating a time and cost efficient aerial imaging system for 3D visualization. 
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These research projects closely resemble the workflow that is outlined in this thesis. 

Ducke focuses heavily on the full workflow of 3D reconstruction from beginning to end. 

The article emphasizes the importance of recognizing legislative and financial constraints 

that many research pursuits endure. The article also highlights the necessity for new 

technologies to be simple, robust, cheap, and efficient in order to have a positive effect on 

industries. This approach is directly in line with the goals of this thesis. Multiple freeware 

and open source components are utilized throughout the tool chain to accomplish the 3D 

reconstruction, such as Bundler and MeshLab [25][26]. The Lewis research project 

evaluates the use of low-cost UAVs to capture aerial imagery in emergency response 

situations. The proposed platform is able to provide timely acquisition of high resolution 

imagery with very limited flight training for a relatively low cost ($8,000). This project 

provides an excellent example of a small-scale research process which utilizes similar 

beginning-to-end steps to the proposed thesis. Tonkin et al. explore the potential 

applications of unmanned aerial systems integrated with SfM to develop topographic 

surveys. This research project successfully communicates the accuracy, precision, and 

potential applications to their specific surveying approach. This project strives to produce 

digital elevation datasets that are comparable to LiDAR in accuracy, but with a fraction 

of the time and monetary cost [27] [28]. The work being pursued by Dr. Block-Berlitz is 

attempting to demonstrate a near real-time application using an aerial imagery-SfM-3D 

reconstruction workflow, but most research is still in progress. Majority of research 

developed by Block’s team is published on their website and has been presented at 

numerous conferences[29], which have been positively received. The common thread 
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between these overarching projects is the need for interdisciplinary integration of 

technologies within a geospatial application. These articles serve as guidelines for the 

structure of the thesis as well as present successful examples to compare and contrast the 

thesis research. 

 

2.3 Aerial Systems and Imagery 
The use of aerial systems within the fields of photogrammetry and remote sensing has 

drastically evolved in the past decade, using cutting-edge technologies to advance its 

capabilities. Unmanned aerial vehicles such as drones have transitioned from being 

highly exclusive property of the defense industry to readily affordable and operational to 

the public [6]. Within the past five years technologies and methods have developed that 

push the known boundaries of photogrammetry and remote sensing acquisition and 

processing methods [3]. This surge of accessible, affordable, aerial vehicle technology 

and processing equipment combined with publically available and refined computer 

vision software contribute to the exponential growth of research and applications for 

aerial systems and imagery [3]. 

The most common and traditional methods of low altitude aerial imaging are 

captured using unmanned vehicles which include kite, balloon, blimp, fixed-wing, and 

rotor aircraft [30] [3]. As mentioned above, the introduction of multi-rotor platforms such 

as drones into the public realm within the past few years has caused an aerial imagining 

revolution [31]. The ideal application of UAVs involves the technical precision and 

autonomous navigation capability that allow efficient capture and flight time. Despite the 
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advanced technology used with UAV platforms, there are viable options for customers 

that require minimal training and piloting knowledge to utilize [8][32]. 

 

2.4 Structure from Motion 
Structure from motion is the automatic estimation of 3D scene structure and camera 

position calculated from a sequence of images. SfM utilizes computer vision technology 

to perform algorithms that identify similarities and differences between images and 

subsequently deduce spatial depth. SfM is an ongoing and active field of research within 

computer science, requiring algorithm and computationally intense processes. The 

premise of SfM relies on quality digital photos captured from one or various sources. 

Studies have been performed using different camera specifications, such as wide-lens, 

fisheye, stereo, catadioptric, pinhole, and multi-camera systems [33]. With each camera 

system having its strengths and weaknesses, the quality of most SfM results are relative 

to the desired outcome.  

Due to computationally heavy algorithms, SfM witnessed restricted use on most 

commercial and public computers through the 2000’s [19]. SfM has only recently been 

introduced to the public domain in the form of media exploration applications, such as 

Microsoft’s Photosynth and AutoDesk’s 123D [34][35]. With the resurgence of SfM as 

an accessible method of 3D reconstruction there are numerous opportunities to explore its 

geospatial application. Two open-source SfM systems that have been developed through 

university and independent research are Bundler and VisualSfM. These SfM platforms 

have continually been improved throughout the duration of their existence by ambitious 



13 

 

contributors, making them comparable and sometimes superior to the commercial SfM 

solutions. A significant contribution to the realm of SfM known as Clustering Views for 

Multi-view Stereo (CMVS) was developed in 2010 by Yasutaka Furukawa and Jean 

Ponce [36]. The software they developed is able to take a SfM result as input and 

significantly increase the visual accuracy and density of the scene for 3D reconstruction. 

This revolutionary approach to high-density SfM advanced the entire field of computer 

vision research and 3D reconstruction from imagery. VisualSfM and Bundler both utilize 

CMVS as optional additional steps within the software. Certain elements of the CMVS 

pipeline are used for real production purposes by Industrial Light & Magic, Weta Digital, 

and Google Inc [37]. The SfM algorithms used by VisualSfM are a culmination of years 

of computer vision research developed by Yasutaka Furukawa and Jean Ponce and other 

research contributors, compiled into the software environment by Changchang Wu [36], 

[38]–[40]. VisualSfM also uses a widely approved method of image matching known as 

Scale Invariant Feature Transform (SIFT). This mathematical approach developed by 

David Lowe is able to transform image data into scale-invariant coordinates relative to 

local features, in other words: identify similar pixel groupings and shapes between 

images [41]. SIFT application has substantially improved the field of computer vision 

and object detection algorithms, allowing processes such as SfM to flourish. 

 

2.5 3D Reconstruction 
Digital 3D reconstruction and model building are vast fields of research and application. 

The utilization of some form of 3D digital models can be found in almost every industry 
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worldwide, such as municipal mapping, national defense, industrial monitoring, and 

entertainment, just to name a few. There are countless programs that are used 

commercially and publically for 3D model manipulation, but few are open source and 

good quality. Two open source software platforms that are used for 3D reconstruction are 

MeshLab and Blender [26]. MeshLab is a widely accepted open source platform for 

manipulating 3D environments, models, and point clouds [2], [27], [42]. It contains a 

simple user interface with limited navigation, but excels with the application of 3D data 

manipulation and mesh construction. The platform contains a large community of 

developers and contributors who continually improve and add plug-ins. MeshLab is 

commonly used for preliminary 3D data optimization and cleaning, but also contains the 

ability to produce and finalize 3D models with high-resolution photo-realistic textures. 

Most of the built-in functions available in MeshLab for 3D reconstruction are considered 

the ideal approach, such as Poisson’s Surface reconstruction [43]. The Poisson Equation 

was originally developed from Issac Newton’s law of gravity [44], and was first actively 

applied towards 3D mesh reconstruction by Kazhdan et al. [45], and since has become an 

optimal approach to 3D surface reconstruction. Other surface reconstruction algorithms 

include Marching Cubes, Ball Pivoting, Power Crust, Tight Cocone, and Delaunay 

Triangle [46]–[49]. All of these algorithms have been designed to reconstruct scenes that 

can be viewed from every angle, having difficulty with partial objects. Poisson's 

reconstruction is found to be a universal and rapid reconstruction algorithm able to 

produce acceptable results with minimal cleaning. The purpose of applying the equation 
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is to solve an unknown target mesh with known topology (e.g. point cloud) but unknown 

geometry, resulting in accurate estimations of object surface. 
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CHAPTER THREE: METHOD APPLICATION 

This chapter elaborates the equipment, method, and process for each step of the thesis 

workflow (see Appendix A). Each section of this chapter systematically details every 

action performed during the project survey. The results of this workflow are summarized 

in chapter 4. The chapter is organized as follows: section 3.1 presents an overview of the 

project location, schedule and overall workflow; section 3.2 details the data capture 

portion of the project; section 3.3 specifies the procedures used in VisualSfM for the SfM 

step of the project; and section 3.4 concludes with instructions for creating the final 3D 

reconstruction of the survey area. 

 

3.1 Overview 
The accessibility of consumer-line 3D technologies such as AutoDesk’s 123D Catch 

(“Catch”) and Microsoft’s Photosynth are advantageous to nearly all applications of 3D 

scene reconstruction. These programs have the capability to fabricate 3D models of 

objects or scenes from a series of photographs by using photogrammetry or SfM. The 

benefits of these software are their ability to perform all steps within the reconstruction 

pipeline, from photograph capture, to calculations, to rendering. The final results from 

these commercial solutions have a high likelihood of being satisfactory for visual analysis 

or rough 3D model construction. The entire workflow of processes in Catch and 
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Photosynth are considered “black box” or proprietary. Although the simplicity of this 

software is a significant benefit, the inability for the user to customize or manipulate any 

step in the process is a significant hindrance. For many applications of 3D modeling such 

as research, emergency response, and topographic surveying, the specifications for a 

desired output must be customizable. Until consumer-line 3D technologies allow 

additional customization and user-input variables, open source alternatives provide the 

flexibility and personalization needed for precise science. 

Despite being streamlined and optimized, consumer 3D technologies such as 

Catch and Photosynth suffer limitations. First, there are restrictions on the number of 

pictures that can be used for the 3D reconstruction. When using the mobile application of 

Catch, the user is limited to a maximum of 40 photos, and the desktop application 70. 

VisualSfM is only limited in number of photos to the processing power of the computer 

workstation. Second, the technology and algorithms used within Catch and Photosynth 

are contained within proprietary online repositories which require the captured photos be 

uploaded to private servers. During the upload process the original photos are reduced in 

spatial resolution and digital complexity, which severely limits the overall accuracy and 

quality of SfM results and final texture projection on rendered models. VisualSfM 

provides a real-time process log that identifies all algorithms and functions performed. 

Third, the output 3D mesh and texture map from the commercial programs are given an 

arbitrary size due to lack of built-in functions to specify a desired output model size. 

VisualSfM allows metadata variables to be applied when exporting final point clouds and 

3D meshes to improve proper scale. Fourth, and most limiting of all is the complete black 
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box nature of the commercial products. It is essential to understand and follow the 

process of SfM and 3D model reconstruction in order to full utilize the output results. 

Without mathematical justification and explicit procedures the results from Catch and 

Photosynth are merely visual assets without direct scientific applications. Using 

VisualSfM to perform the SfM process on the database of captured imagery optimizes 

algorithm customization. 

 

3.1.1 Location 
The location of interest that is the focus of most aerial imagery data acquisition is the 

Green Acres Center and property located at 4401 Sideburn Road, Fairfax, VA 22030. 

This facility presents many opportunities for using aerial photography, most crucial being 

an open area with limited vertical obstructions. Although the results of this research 

should be applicable to all uses of aerial imaging, the conditions for this study were 

performed in a near-optimal, accessible, safe environment. There are numerous locales 

within the AOI to test the research process upon, such as: residential suburban, large 

commercial facilities, institutional facilities, large storage buildings, transportation 

features, industrial/infrastructure features, and sparse forest/fields. The overall accuracy 

of the research method will be vetted against surveyed CAD datasets of most of the 

surrounding structures within the GMU campus and housing complexes (Table 3). 
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Figure 1 - Study Site: Green Acres Center facility and surrounding area 

 

 

There are three steps that should be consulted when determining a good site to perform 

kite aerial imaging [50]. 1. Identify an open launch site. 2. Observe patterns in wind 

direction. 3. Determine launch site in relation to mapping target. Steps 1 and 3 were 

determined through surveying and presented an ideal pairing of nearby launch site and 

target mapping area. Step 2 is clearly the more variable factor, but predominant wind 

direction comes from the south and blows in a north-northwest direction ranging from 5-

10mph at the ground surface. A minimum wind speed of 5mph is required for a 
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successful kite liftoff with the additional 2.6oz of camera equipment. Further observation 

of the target AOI revealed advantageous wind funnels and choke points that were created 

from the community building and tree lines. 

A mandatory step that must be taken when aerial imagery is involved is 

referencing FAA regulations. Being situated so close to Washington D.C., which 

prohibits UAV flight and aerial imagery, it is especially important to adhere to 

uncommon federal regulations. Research has determined that the flying of kites according 

to the common standards being used in this study are well within the acceptable federal 

aviation regulations, such as: <500ft kite altitude, daytime operation, operator presence, 

and acquisition of proper permissions for kite operation [51]. 

 

3.1.2 Schedule 
The project execution was divided into three main phases (see Appendix B). Phase 1 

concerned the development of an adequate aerial imaging platform and the acquisition of 

an imagery dataset for later analysis. Phase 2 focused on the utilization of SfM 

techniques for preparation of data and subsequent 3D reconstruction techniques for 

visualization. Phase 3 focused on refining a workflow between all steps and concluding 

integration of phases 1 and 2. 

Phase 1 of the research project began by testing ideal methods of aerial 

photography methods within the field. The decision to use a kite for the project is for 

several reasons: cost effective, minimal training required to pilot, relatively navigable, 

and accepted culturally worldwide. These simple reasons promote the use of a kite for 



21 

 

easy and cost-efficient aerial photography. Alternate photo capture techniques were 

considered as potential supplements to producing adequate datasets. The kite was 

attached with a sufficient camera and a wireless uplink connected to the processing 

workstation. The camera produced multiple copies of the digital data collected, one copy 

on the micro SD card within the camera, and the second copy wirelessly transferred in 

real-time to the workstation. The designated study site, Green Acres Center (Figure 1), 

presented an ideal location for aerial platforms and data validation with agreeable 

weather conditions and public availability. 

Multiple field work sessions occurred throughout the project duration. Initially a 

large imagery dataset was successfully acquired using the proposed methods. This initial 

data in digital format was used as the primary image dataset for later SfM and 3D 

reconstruction steps. Phase 3 required additional active field work collection of aerial 

imagery to demonstrate a working example of the proposed end-to-end rapid real-time 

3D reconstruction workflow. The thesis schedule offered flexibility to allow additional 

field work to occur if necessary. 

Phase 2 encompassed the analysis of imagery using SfM and 3D reconstruction 

techniques. The goal of this phase was to demonstrate a workflow with minimal user 

input that performs SfM and produces an acceptable 3D reconstruction from the captured 

imagery dataset. This phase will utilized open source and freeware platforms to execute 

the analysis. Most of the SfM platforms mentioned (see section 2.4) have been developed 

by rigorous research labs and are capable of executing the necessary algorithms with 

optimal speed and simplicity. The SfM process ingests all relevant aerial images from the 
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dataset and using the accepted algorithms, produce a point cloud representing a sparse 

model of the captured environment. The point cloud data is then imported into the 3D 

rendering and reconstruction platform for final visualization (

). The final 3D rendering ideally has potential use for future applications. A personal 

laptop was utilized as an ideal field work device, containing medium-high processing 

power and RAM ratings and wireless compatibility. During phase 2, most of the 

processing and analysis occurred on PC to ensure data and method integrity. The 

resulting workflow and procedure demonstrated from this phase was developed for 

compatibility with the laptop environment to perform the phase 3 integration. 

Phase 3 integrated the processes demonstrated in phase 1 and 2 into a continuous 

workflow capable of visualizing 3D environments. The result of this final phase 

demonstrated an end-to-end method capable of capturing aerial imagery via kite, 

transferring the imagery rapidly to a workstation, processing the imagery with SfM, and 

rendering a 3D environment, all done in rapid succession. The challenge of this phase 

was to ensure that each step of the workflow was running correctly and producing the 

desired results. Ideally, the final workflow will be able to automatically proceed through 

each step of the process with minimal user interaction, made possible through future 

research. 
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3.1.3 Process Workflow 
The process workflow presented in this thesis was developed specifically to perform the 

intended tasks using the data, software, and hardware outlined prior. A general synopsis 

of the process workflow is given in this section (Error! Reference source not found.), 

with extensive details provided in the remaining sections of the chapter and workflow 

shown in Figure 3. The simple process workflow is: data acquisition, SfM analysis of the 

image dataset, and 3D model reconstruction. All data acquired for the research will 

undergo post-processing or conversion, quality inspection, SfM analysis, removal of 

redundancies or incompatibilities, and point cloud construction. The completed SfM 

results and point clouds are then combined to form a cohesive 3D environment or model. 

Further research will determine the capability of implementing more rapid processing of 

the imagery into 3D environments. 

 

 
Figure 2 - Simple Workflow 
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Figure 3 - Complex Workflow 

 

 

3.2 Data Capture 
 

3.2.1 Equipment 
The equipment used for the data capture portion of the thesis encompasses three items: 

aerial vehicle, imaging apparatus, and connecting harness. The main aerial vehicle used 

in this research project is the kite (Figure 4). The primary kite used in this project is a 
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high-performance delta sport kite with two controlling lines. The delta shape is a 

common kite design used within kite mapping communities due to its lift and 

maneuverability [50]. The decision of using a performance kite was initiated by the 

researcher, having previous experience with such aerial vehicles and realizing their 

benefits. The maneuverability of the performance kite allows advanced motion, 

perspective, and active imagery capture. This added capability of precise steering reduces 

the time and effort needed by using traditional kites, which rely more on weather and 

wind behavior. In addition, alternate delta-kite and anchored balloon vehicles were 

briefly used in the field research for comparison. Sufficient string for anchoring the aerial 

platform is also desired. Spools in excess of 300 feet with a tensile strength greater than 

75 pounds are used. 

 

 

Figure 4 - Aerial platform: Delta performance kite 

 

 

When determining the proper aerial vehicle to use for a field survey, specification of the 

area of interest (AOI) must be identified. There are certain questions that can help 
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determine adequate vehicle applicability, such as: how large of an area is being surveyed? 

Are there limitations or obstructions to aerial vehicles? Is there an open area sufficient for 

aerial vehicle mobility? Are there legal or personal restrictions for surveying the site? Are 

weather conditions favorable for aerial vehicle usage? These questions can help narrow 

the possible aerial vehicle options available.  

This research project uses the GoPro Hero 3 Black edition (Figure 5). There are 

numerous viable options for digital camera equipment [50]. Although there is no 

consensus determining an ideal camera platform, there are a few preferred cameras that 

are highly recommended by researchers and enthusiasts [52]. The model of camera 

depends on the capture quality desired and aerial vehicle lift capacity. In most cases there 

is a tradeoff between size and weight of a camera and the quality of images captured. The 

optimal camera selection should allow the best quality image performance while still 

navigable on the aerial vehicle. The GoPro is ideal for aerial platforms due to its 

incredibly lightweight frame (73 grams) and durability.  It also has capture capabilities on 

par with larger cameras, such as time-lapse, wide angle lens, video, and high resolution 

up to 12 megapixels. It has wireless control and uplink abilities, making it an ideal 

camera for this research project. 
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Figure 5 - GoPro Hero 3 Black Edition 

 

 

The apparatus for connecting the camera to the aerial vehicle combines GoPro protective 

casing and adjustable material (Figure 5). Being a highly mobile aerial platform the 

connecting apparatus must be durable, stable, and flexible [50]. There are various 

solutions to mounting a camera on aerial platforms offered by researchers and 

enthusiasts. For kite photography, a common apparatus involves an empty plastic bottle - 

a solution that is simple, affordable, and reliable [50]. As stated above, the most 

significant limitation to aerial platforms is the weight restriction imposed by adding a 

camera. The increase in weight reduces the stability and control of the aerial vehicle 

while increasing the demand for lift. The solution for this project incorporates a 

lightweight, bare-minimum harness developed for this situation. The harness uses the 

backing from the GoPro plastic protective casing and is fastened to the central support 

frame of the kite using articulated wire. The camera is held in the plastic backing with at 

least three rubber constraints to ensure a firm hold while allowing easy removal. The 

weight of the camera is fully supported by the wire, and additional stability is provided 
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by strings anchoring the harness to more portions of the kite frame. The harness allows 

adjustments for both oblique and nadir image capture. Attachment and removal of the 

apparatus requires minimal time or adjustment.  

The workstation used in this research project is an HP Pavilion laptop dv6, which 

contains an i7 quad-core processor, 4 gb DDR3 ram, nvidia graphics card with Cuda, 250 

gb hard drive, wireless card adapter, and uses Windows 7 operating system. The 

components highlighted above are crucial for the computer and are highly recommended 

for most of the steps in this study (image transfer, SfM algorithm, 3D reconstruction) 

[53]. All of these computer aspects are essential to perform this study, but varying levels 

of capability are allowable. Having a high-performing, multi-core processor and more 

ram will display the most significant improvement in workstation functions. Some of the 

open source programs and scripts used later in the study may not function properly on a 

Mac or Linux system. Using a laptop is essential for portability and processing in the 

field. The wireless card allows the workstation to communicate with the camera (GoPro) 

which has an internal Bluetooth-compatible wireless network, allowing wireless transfer 

of images. It is recommended to have charging capabilities on-hand during field work 

sessions in case of substantial battery loss. 

 

3.2.2 Setup and Planning 
The ideal setup for the capture procedure requires all aforementioned equipment, 

sufficient power, wireless connectivity, and access to the survey AOI. Having determined 

the survey location and gained surveying permission, optimal weather and lighting 
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conditions must be projected [50], [52]. With a couple potential dates selected having 

optimistic weather conditions the schedule is arranged. All equipment must then be 

prepared. 

The GoPro camera has a wide variety of capture settings which greatly ease the 

process of image acquisition. The significant setting which is used in this project is ‘time-

lapse’, allowing the camera to automatically take a picture every ‘x’ seconds, from ‘0.5’ 

to ‘1 min’. Once activated, this setting will continuously capture and feed images to the 

workstation wirelessly. In an ideal situation, a high-definition video feed would be 

optimal, but the degree of technology and wireless bandwidth required is superior to the 

goals of this research project. A balance between the quantity and quality of images must 

be determined due to limitations on the speed of wireless transfer between devices. The 

optimal balance of image capture frequency is deemed acceptable from 1 to 3 seconds 

between pictures. 

The primary dataset required for performing SfM and 3D reconstruction must be 

composed of a series of compatible images, in this case the GoPro images are JPEG. The 

quality of image must be established prior to collection, and should be determined by the 

pixel resolution of the image. The higher spatial and pixel resolution of images will result 

in higher fidelity surface reconstruction and final texture application [53], [54]. Two 

resolution settings are used in this study, 12 megapixel wide-lens, and 5 megapixel 

medium-lens. Depending on the camera system, the lens used may cause visual 

alterations to the image, such as pin-hole or fisheye effect. These visual effects are easily 

removed after capture through batch filters to ensure accurate visual representation of the 
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scene. Graphic editing software such as GIMP, which is freeware found online at 

http://www.gimp.org, is capable to solving these lens distortions. Some SfM platforms 

are capable of processing raw images that contain skewed lens alterations. 

The camera system and workstation must have the proper setup to allow wireless 

transfer of images. The GoPro system must have been properly set up upon initial 

activation. If so, the GoPro has wireless capability simply by activating the wireless 

setting, which is done manually or via remote control. Similarly, the workstation must 

have the basic wireless functionality established prior to device connection. The GoPro 

creates its own wireless network which appears as a network option on the workstation. 

Once selected, the GoPro network requests the previously established password for 

successful connection. There are numerous ways to transfer images from the GoPro, the 

fastest being through direct link with a USB cable. If all other methods fail, using the 

USB cable on-site is a viable option with rapid results. The wireless transfer of imagery is 

an optimal situation for continuous surveying and scene reconstruction, and is a goal of 

this research project. Using a windows explorer window, the GoPro device storage can be 

accessed via the ip address: //10.5.5.9:8080 (Figure 6). Direct access to the camera 

storage allows immediate transfer of the captured images to the workstation hard drive by 

using simple copy scripts. 
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Figure 6 - GoPro wireless directory 

 

 

The workstation should have maximum processing functionality activated, and if 

possible, plugged in. The transfer of images over wireless and later SfM and 3D 

reconstruction demand full workstation attention. The workstation needs to have 

sufficient hard drive space to store the raw images transferred from the GoPro and later 

SfM and 3D models. A dedicated folder is created on the hard drive to store the raw 

images transferred from the GoPro. This separate folder ensures the image series integrity 

with later processes that might alter the source image. 

 

3.2.3 Capture Procedure 
Upon completing setup on site, aerial surveying commences. Multiple field work sessions 

occurred within the duration of this project, with aerial surveying successfully 
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accomplished with single and dual teams. Regardless of survey team size, the capture 

procedure remains nearly identical, and is as follows: 

a. Verify device power and wireless connections: GoPro, Workstation. 

b. Position the aerial vehicle (kite) downwind of the navigator. 

c. (optional) If using manual camera activation, begin time-lapse capturing. 

d. If using remote or smartphone app, begin time-lapse capturing. 

e. Launch aerial vehicle, navigating around AOI. 

f. Monitor the transfer of images on the workstation, adjust flight as needed. 

g. Once desired number of images are captured, land aerial vehicle. 

h. Review transferred images for error and AOI scene gaps. 

i. If more images are needed, repeat steps until results are satisfactory. 

Each of the numerous surveys performed for this project successfully captured over 100 

usable images and were completed in less than an hour. For other project surveys 

depending on location, weather conditions, and flight success, other field sessions may 

need to be scheduled. 

There are additional capture techniques to consider when acquiring images for 

SfM. The image series needed for optimal SfM processing requires a different approach 

than traditional photography. The following is a list of guidelines for proper image 

acquisition compiled from sources [49], [54], [51]: 

a. SfM projects need a minimum of 3 images to run properly. 

b. Image resolution should be at least 1-3 megapixels (1280x960 – 2048x1536). 

c. Ensure sufficient environmental lighting. If flash is needed, it is too dark. 
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d. Once camera parameters are set, do not change them throughout collection. 

e. Make sure the image series contains significant overlap between photos. 

f. Move the camera positioning with each photo: adjusting the perspective by 

10-20 degrees as well as height can improve overall output. 

g. Attempt to maintain a controlled capture environment, with minimal moving 

objects. 

h. The larger a capture environment, the more images will be needed. There is 

no limit to the number of pictures VisualSfM will integrate, but processing 

time will substantially increase. 

i. If there are gaps or holes between the photo perspectives they will have to be 

filled with additional images to ensure wholesome SfM reconstruction. 

 

3.2.4 Upload and Conversion 
This step of the capture process appears in the complex workflow (see Appendix A). If 

during the aerial survey wireless connection fails between the GoPro and workstation, the 

images stored on the camera can be easily uploaded manually. Using either a micro-SD 

adapter or mini-USB cable the GoPro is able to directly upload all images onto a 

compatible computer rapidly. Although this manual step detracts from the live-stream 

advantage used in this project, it may be a necessary step pending a failed wireless 

connection. Following a successful aerial survey it may be necessary to convert or 

transform the image series into optimal formats. As mentioned in 3.2.2, certain camera 

platforms use wide-angle lens that may cause distortion to the image. For most SfM 
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pipelines it is preferred that input images have as little distortion as possible to best 

represent accurate depth and shape [38]. There are a few software solutions to correcting 

image distortion: Adobe Photoshop, DxO, and GIMP. Out of these software options, only 

GIMP is freeware. Some cameras, such as the GoPro, have high resolution captures 

settings (12 megapixels) but are only available in wide-lens which causes severe 

distortion. In this project, the GoPro was set to capture at 7 megapixels to reduce the 

degree of distortion while sacrificing some image detail. No image conversion is needed 

when using 7 megapixel medium-lens with the GoPro. 

All of the uploaded images on the workstation are now able to be visually 

reviewed. The image series from the aerial survey must be looked over to determine the 

quality and applicability of each image. Even though VisualSfM has the ability to deduce 

image usefulness via algorithm, it is beneficial to quickly review and remove extraneous 

images. Each image incorporated into VisualSfM increases processing time 

exponentially, which depending on the total number of images and computing power 

could translate into a few extra seconds or even minutes to process [54]. 

3.3 Structure from Motion 
 

3.3.1 Equipment 
The primary equipment in this step is the same workstation used prior (HP Pavilion 

laptop dv6), hardware specifics and advantages are given in section 3.2.1. This step of the 

process uses VisualSfM as the structure from motion platform. VisualSfM is an open 

source platform that employs many cutting-edge SfM algorithms and research tools used 

in computer vision research. VisualSfM is compatible with the major computer operating 
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systems (windows, mac, linux), but may require additional support files for proper 

functionality [56], [57]. The most recent version of VisualSfM is available from the main 

support webpage:  http://www.di.ens.fr/cmvs, called version “fix-2”, updated March 27, 

2011 [37]. The version “fix-2” updated software package comes equipped with additional 

functionality such as CMVS, which greatly improve the overall effectiveness of the 

platform [36]. Installation of the software is clear, but deviations in operating system or 

computer registry files may require additional steps for complete installation. Full 

installation documentation can be found at www.di.ens.fr/cmvs/documentation.html. 

After installation it is beneficial to run the test data tutorial for VisualSfM which comes 

with the full software package. Performing the tutorial will familiarize the user with the 

overall interface of VisualSfM and verify program functionality. 

 

3.3.2 Setup and Preparation 
Prior to performing any analysis with VisualSfM the working directory and image source 

folder must be verified. The image series folder created in section 3.2 is the source folder 

for input images. By default, VisualSfM creates a working folder within the installation 

directory. Unless there are hard drive space issues or user preference, the default working 

location for VisualSfM is satisfactory. 

VisualSfM has the ability to use GPU in addition to CPU, which potentially 

accelerates the processing time. Prior to analysis, the performance settings should be 

maximized to take full advantage of available computer processing power. Within 

VisualSfM the performance settings can be adjusted from Tools > Enable GPU. Settings 



36 

 

such as ‘set maximum dimension’ and ‘match using CUDA’ are excellent options that 

improve performance. Settings should be maximized to best suit workstation capacity. 

The higher performance settings selected, the faster processing occurs, but other 

computer processes suffer [54]. Once the main SfM steps are initiated, it is best to not 

interfere with the workstation, allowing full processing power to be dedicated to the SfM 

task. 

VisualSfM has a simple user interface but has the ability to perform complex 

operations. Although this thesis project only covers the primary uses for the program, 

there are numerous other capabilities built into the software for other applications. 

Throughout the remainder of section 3.3, the procedural steps performed in VisualSfM 

(see Appendix A: Steps A, B, C, D) can be identified on the main UI toolbar (Figure 7) 

[54]. 

 

 

Figure 7 - VisualSfM Toolbar 

 

 

This step begins the VisualSfM portion which can be seen in Figure 3 and Appendix A. 

Opening VisualSfM creates a new project which should be named and saved to the hard 

drive. The first step in the VisualSfM workflow is loading or importing the image series 
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(see Appendix A: Step A). Press the ‘Select Multiple Images’ button to initiate the 

loading prompt (Figure 8).  

 

 

Figure 8 - Step A 

 

 

Select all of the desired images for the analysis and import them. The selected images 

will appear as a thumbnail grid in the VisualSfM UI (Figure 9). From here more images 

can be added to the series or undesirable images, such as duplicates or blurry, can be 

removed. Note that while all processes run in VisualSfM a log tracks every action. This 

log is very useful for monitoring CPU performance and keeping track of processing time 

or errors in the workflow (Figure 9). 
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Figure 9 – Image thumbnails and Log 

 

 

Once the image series is completely loaded into the VisualSfM environment, the 

workflow can proceed to Step B, SIFT reconstruction. 

 

3.3.3 SfM Algorithm 
The SfM algorithms used by VisualSfM are a culmination of years of computer vision 

research developed by Yasutaka Furukawa and Jean Ponce and other research 

contributors, compiled into the software environment by Changchang Wu [36], [38]–

[40]. VisualSfM uses a few steps in the SfM pipeline: SIFT, sparse reconstruction, and 

dense reconstruction. SIFT is a GPU-accelerated feature detection and bundle adjustment 

for the SfM system. The SIFT operation systematically analyses all the images within the 

VisualSfM environment. The result from SIFT creates a metadata file documenting all 



39 

 

identified objects in an image and all similarities between the other images in the series 

(Figure 10). 

 

 

Figure 10 - VisualSfM: SIFT example 

 

 

The second step with VisualSfM is to perform the SIFT operation (Figure 11). This step 

performs the SIFT operation which identifies the unique features within each image. 

Next, the process matches the SIFT features between all the images in the series. The log 

will track the image SIFTed, the number of unique features detected within the image, 

processing power dedicated, elapsed time, and number of similar features between each 
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image pair compared (Figure 11). The amount of processing time required for this step is 

relatively low, but the number of image comparisons needed will grow exponentially 

relative to the number of images used in the series. This portion of VisualSfM can take 

advantage of workstations that have a GPU to accelerate the process. As mentioned 

earlier in the section, it is preferable to not interfere with the workstation while the SfM 

procedure is occurring. Fortunately, if the processes during Step B are interrupted for any 

reason, VisualSfM is able to track the progress of the analyses and resume SIFT and 

matching where the pipeline ceased. 

 

 

Figure 11 - Step B 

 

 

The next step with VisualSfM is performing Sparse Reconstruction (see Appendix A: 

Step C). This procedure in VisualSfM incorporates all previously determined 

relationships and metadata within each image and the image series and attempts to 
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construct a rough 3D representation of camera positions and object locations. After Step 

B is performed, Step C is easily initiated by running ‘Compute 3D Reconstruction’ 

(Figure 12).  

 

 

Figure 12 - Step C 

 

 

During this step VisualSfM systematically displays all of the computed photographs 

according to their approximate perspective. As each image is added to the display the 

computed 3D model continues to grow or “solve” (Figure 13). While the program 

attempts to solve using all the input images the display interface can be navigated, 

presenting a real-time environment to witness the sparse 3D reconstruction. Sometimes a 

few separate 3D solves are computed due to inadequate overlap between the images in 

the series. These separate solved models will appear in the log window along with the 

images used to create them. If rogue image solves occur that are separate from the 

primary model, additional photos may have to be captured or manual relationships 

defined to patch the gap. Another option is to remove the images that are causing 

confusion for the 3D reconstruction. There are two methods for removing unwanted 

images from solved models [54]. 

Method 1:  
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1. Turn off 3+ 

2. Press F2 – select bad 3D points 

3. Click “ ” icon twice – deletes camera with the most points selected 

4. Repeat from step 1 if bad points remain 

5. Click “ ” to grow the modified model 

Method 2:  

1. Press F1 – draw rectangle to select bad cameras (250 camera maximum) 

2. Click “ ” icon to remove all selected bad cameras 

3. Click “ ” to grow the modified model 

 

 

Figure 13 – Step C: VisualSfM Sparse Reconstruction 
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The final output of the computed sparse 3D reconstruction is the best-estimate position of 

all the input camera perspectives and a sparse point cloud of the object similarities 

between all the images. This constructed environment can be navigated in the display UI 

and checked for integrity. 

The final step using VisualSfM is creating the dense reconstruction (see Appendix 

A: Step D). This operation is only available from the toolbar if the previous step C has 

completed successfully. The dense reconstruction process uses the sparse 3D 

reconstruction as a foundational benchmark and improves the point cloud density by 

identifying additional features within the image series [36]. The operation is initiated by 

selecting the “Compute Dense 3D Reconstruction using CMVS/PMVS” button from the 

toolbar (Figure 14). 

 

 

Figure 14 - Step D 

 

 

Beginning the dense reconstruction procedure activates a dialog to create a working 

folder to save the resulting files and computations. Once again the folder name and 

location are arbitrary as long as they can be located for future application. Step D creates 

numerous output files that reference different aspects of the dense reconstruction. The 
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three output files that are of most concern for this project are: bundle.rd.out, list.txt, and 

NamedDenseCloud.ply. Having created the working folder for CMVS, VisualSfM 

commences the dense reconstruction algorithms. This step requires more computing 

power than StepB or C, and will not visually display the results as it progresses. The log 

will continue to update CMVS status as each stage of the analyses proceeds (Figure 15). 

Once completed, the dense reconstruction results from CMVS can be viewed in the UI 

display by activating “View > Dense 3D Points”. The result displayed in the UI 

represents all of the estimated camera perspectives along with a more dense view of 

object points identified within the image series (Figure 15). 

 

 

Figure 15 - Dense point cloud 

 

3.3.4 Point Cloud Export 
It is important to note that all features established as matching between the images are 

represented as points within the display UI. Step C resulted in a sparse point cloud, 
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effectively showing the prominent features that at least 3 cameras similarly agreed upon. 

Step D applied algorithms that progressed deeper into each image and identified 

additional features and similarities, creating a denser point cloud. The output files created 

from Step D (bundle.rd.out, list.txt, NamedDenseCloud.ply) are automatically compiled 

within the working folder established before the process runs. Bundle.rd.out is considered 

a project file type and contains imbedded information about the sparse point cloud and 

the images used during 3D reconstruction. List.txt contains the camera perspective 

information which is used for projecting the texture over the 3D mesh. 

NamedDenseCloud.ply is the dense 3D reconstruction result from CMVS and contains 

the dense point cloud output from Step D. Following a successful completion of Steps A-

D, the three output files from VisualSfM are prepared for further 3D reconstruction in 

MeshLab. 

 

3.4 3D Reconstruction 
Following the established workflow the output point cloud from VisualSfM is imported 

into MeshLab for 3D reconstruction (see Appendix A: Step E). MeshLab is the primary 

open source program utilized in this study for 3D model reconstruction. MeshLab is a 

widely accepted open source platform for manipulating 3D environments, models, and 

point clouds [2], [26]. The platform contains a large community of developers and 

contributors who continually improve and add plug-ins. Most of the built-in functions 

available in MeshLab for 3D reconstruction are considered the ideal approach, such as 

Poisson’s Surface reconstruction [43], [45]. MeshLab is commonly used for preliminary 
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3D data optimization and cleaning, but also contains the ability to produce and finalize 

3D models with high-resolution photo-realistic textures. 

3.4.1 Equipment 
The primary equipment in this step is the same workstation used prior (HP Pavilion 

laptop dv6), hardware specifics and advantages are given in section 3.2.1. This step of the 

process uses MeshLab as the 3D reconstruction platform. MeshLab is an open source 

platform that employs many current rendering and manipulation tools used in 3D 

modeling [26]. A brief list of MeshLab capabilities include: editing, cleaning, healing, 

inspecting, rendering, and converting 3D meshes [26]. The program also has a diverse 

compatibility library, being able to import and manage at least 18 major data types and 

file extensions. The MeshLab program began in 2005 within the computer science 

department of University of Pisa, developed mostly by students. The platform continues 

to receive technical support and upgrades, the most recent update of MeshLab version 

1.3.3 was released in April 2014. The software is available on all major operating 

systems (windows, mac, linux), but known installation problems exist. Full installation 

documents for each operating system can be found on the main MeshLab website: 

http://MeshLab.sourceforge.net [26]. There are test datasets installed along with 

MeshLab that are available for tutorial. Performing the tutorial will familiarize the user 

with the overall interface of MeshLab and verify program functionality. 
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3.4.2 Setup and Planning 
MeshLab is a well-designed open source program providing complex, advanced 3D 

techniques with a simple to install-and-use interface. The amount of processing 

demanded by the program is directly related to the size (mb/gb) of the dataset it is 

managing. MeshLab has the capacity to handle millions of points and thousands of 

polygonal mesh faces, which is more numerous than the datasets tested and used in this 

project. The toolbar available in the program UI contains the most frequently used 

functions for basic rendering and navigation (Figure 16). There are hundreds of 

additional functions and algorithms built into MeshLab accessible through the “Filters” 

and “Render” menus. 

 

 

Figure 16 - MeshLab Toolbar 

 

 

The first step (Step E) using MeshLab begins with loading the output project created in 

Step D, section 3.3.4 (see Appendix A: Step E). This step is straight-forward because 

MeshLab has the built-in functionality to read and load the file types created from 

VisualSfM dense reconstructions. Select the “Open Project” button and navigate to the 

bundle.rd.out file created in step 3.3.4. Once this file is located and selected MeshLab 

will also prompt for the related camera file, list.txt, which is then selected. The data will 
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only take a few moments to load into the program environment. Loading all of the files 

should have also opened the Layer Dialog window. If this window is not visible, activate 

it through selecting View > Show Layer Dialog (Ctrl+L). In addition to displaying the 3D 

point cloud, the Layer Dialog window also includes all of the images used during the 

creation of the point cloud in VisualSfM. At this time a point cloud is visible in the main 

display window and the two data windows on the side of the UI contain the point cloud 

layer (called a “mesh” in MeahLab) and all the image files (Figure 17).  

Prior to beginning the next step, navigate around the main display to inspect the 

point cloud integrity. The images in the Layer Dialog can also be selected which will 

reposition the user perspective to that of the selected camera. The size of the camera 

views and point cloud vertices can be adjusted for improved visibility. 

 

 

Figure 17 - MeshLab UI 
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Following the successful loading of the project, the dense point cloud produced in section 

3.3.4 is swapped into the project, replacing the sparse point cloud (see Appendix A: Step 

F). This step is needed because the project file bundle.rd.out only contains the sparse 

point cloud and camera positions. By switching to the dense point cloud MeshLab is able 

to retain the proper camera positions and image textures for later application on a much 

higher fidelity 3D mesh. First the current “mesh” (sparse point cloud) must be removed, 

which is done by right-clicking the model in the Layer Dialog and selecting “delete 

current mesh”. All that remains in MeshLab are the images and corresponding camera 

positions. Then select File > Import Mesh, selecting the NamedDenseCloud.ply model 

file from the output working folder from 3.3.4. Executed correctly, this step presents the 

much higher density point cloud produced by the CMVS algorithm in VisualSfM (Figure 

18). Similar to above, use the display UI to navigate around the 3D scene and identify 

visual continuity. 
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Figure 18 - MeshLab: Dense point cloud 

 

 

 

The next step involves cleaning the dense point cloud dataset of extraneous or unwanted 

points, which is necessary for improving 3D mesh reconstruction using Poisson’s 

algorithm (see Appendix A: Step G). A drawback is that this step requires actual user 

manipulation of the point cloud dataset. Due to scene interpretation and possible user 

error, it is best to have a user that is familiar with the scene and data collected. Not all 

bad points need to be cleaned at this time. This cleaning procedure can be applied 

progressively as Poisson’s mesh is created and adjusted in the subsequent section. To 

select unwanted vertices select the “  “ button on the toolbar. Highlight the bad 

vertices that are far from the scene center or visibly incorrect according to the knowledge 

of the AOI. By holding Ctrl or Shift on the keyboard while highlighting vertices, 

groupings of vertices can be added or remove from the selection. With a collection of 

vertices selected, pressing the “ ” button will delete them from the MeshLab dataset. It 
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is important to note that the vertices will not be deleted from the original 

NamedDenseCloud.ply file, which allows room for trial-and-error. Once the point cloud 

is cleaned to satisfaction it can be analyzed by the 3D surface reconstruction algorithm. 

 

3.4.3 Algorithm Application 
Applying the Poisson’s surface reconstruction algorithm is a simple step, but contains 

many possible variables (see Appendix A: Step H). Due to the many outcomes that can 

emerge from the Poisson variables, this step is highly adjustable and must be approached 

precisely. Poisson’s surface reconstruction is initiated by selecting Filter > Points > 

Surface Reconstruction: Poisson. Activating Poisson’s reconstruction prompts the user 

for 4 input variables to adjust the output mesh: Octree depth, Solver divide, Samples per 

node, and Surface offsetting (Figure 19).  

 

 

Figure 19 - MeshLab Poisson's parameters 
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Each of these variables slightly alter the algorithm for building the 3D mesh. For a much 

more detailed explanation of the variables, refer to the original document from the 

developers of the Poisson’s reconstruction [45]. In short, the octree depth has the most 

significant control over the detail of the mesh. The higher the parameter number 

becomes, the more detailed the result will be in relation to the point cloud, but with a cost 

of processing speed (Figure 20). The samples per node parameter defines how many 

points the algorithm puts into one node of the resulting octree. If the point cloud is rough 

or noisy a high sample per node value will smooth the mesh result, while a low value will 

retain model detail (Figure 20). Beginning with the default parameter values will 

establish a baseline for the numerous iterations of Poisson’s surface reconstruction. 

 

 

Figure 20 - Poisson results 

 

 

Step H may require multiple iterations of Poisson’s surface construction before producing 

a mesh result that is satisfactory to the user. A degree of trial-and-error with Poisson 

parameters will occur before an optimal mesh emerges. Even with a satisfactory Poisson 

mesh some edge cleaning will be required. 
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Step I addresses the final steps of cleaning the Poisson mesh before textures are applied 

(see Appendix A: Step I). The primary objects being corrected in this step are non- 

manifold edges, which are defined as geometry where any edge is shared by more than 

two faces. Some algorithms are unable to process geometry that have non-manifold 

edges, such as the texture application in the next step. This requirement for manifold 

edges may be considered a drawback for MeshLab, creating an extra step in the 

procedure and potential empty holes in the 3D mesh. Non-manifold edges are fixed by 

selecting Filters > Selection > Select Non-Manifold edges > Apply, then deleting them 

with the appropriate feature delete button. Additionally, the mesh is prepared for texture 

application by parameterizing between the input images and the projected faces of the 

mesh. This process re-matches the images and identifies the best camera perspective for 

each face of the mesh. Parameterization is initiated by selecting Filter > Texture > 

Parameterization from registered rasters. Best results have been found from selecting 

boxes 1, 2, 4, and entering “4” into Texture gutter (Figure 21). 

 

Figure 21 - MeshLab Parameterization 
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3.4.4 Texture Application 
Applying the visual texture to the final Poisson mesh is a simple and satisfying step in 

MeshLab (see Appendix A: Step J). Due to the preparations in previous steps, draping the 

imagery on the 3D mesh is quick. Using parameterization from Step I allows the best-fit 

images to be used for each model face. Projecting the textures onto the model is initiated 

by selecting Filters > Texture > Project active rasters color to current mesh, filling the 

texture, using basic weighting. There are a few parameters that need to be defined for this 

step. The texture file is the given name of the texture that is created from this process. 

Pixel size is any power of 2, but usually within the boundaries of the image resolution; 

there is no limit to the size of the texture resolutions e.g. 512, 1024, 2048, and 4096. The 

remaining parameters can be selected by the user, but recommended settings are shown 

below (Figure 22). 

 

 

Figure 22 - MeshLab Project Texture 

 

 



55 

 

Once applied, the image textures appear draped over the 3D reconstructed surface mesh. 

Applying the textures to a model surface creates a significantly improved visual product. 

  

 

Figure 23 - Final Model with Texture 



56 

 

CHAPTER FOUR: RESULTS 

This chapter of the thesis summarizes the results from the project working demonstration 

performed at the proposed AOI using the methods outlined in chapter 3. Each following 

section reviews the input and results from each stage of the workflow. 

 

4.1 Overview 
The final field survey captured 162 usable images and totaled 80 minutes to produce the 

final 3D scene reconstruction from the time of the survey. The sparse point cloud was 

created in 30 minutes within VisualSfM, which is a recognizable point model of the 

scene, and could be easily used for rapid analysis or guidelines for manual feature 

extrapolation. The elapsed-time for the entire workflow beginning from arrival at the 

AOI is documented in the table below (Table 1).  

 

Table 1 - Workflow time 

Step Description Time (min) 

Equipment Boot and sync workstation and camera 5* 

Survey Commence aerial survey and data capture 10 – 40* 

Transfer Transfer images from camera to workstation 5 

Step A Load and clean image series in VisualSfM 3 

Step B Perform SIFT and image matching 20 

Step C Sparse 3D reconstruction (point cloud) 7 
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Step D Dense 3D reconstruction (point cloud) 30 

Steps E-F Load SfM project into MeshLab 5 

Step G Clean bad points in cloud 5 

Step H Execute Poisson surface reconstruction 5 

Step I Clean bad faces in reconstructed 3D mesh 5 

Step J Create and project texture onto 3D model 1 - 4 

Step K Export final 3D model for analysis or 

application 

1 

 *equipment set-up and survey not included  ~80 min 

 

 

Using fewer images throughout the workflow would significantly reduce the overall time, 

with 50 images taking about 15 minutes for a sparse point cloud and 45 minutes for the 

final 3D model. The same 162 images were uploaded into Photosynth to compare 

processing speed for the sparse point cloud, which Photosynth is capable of producing. 

Uploading the images, performing its proprietary algorithm, and producing the final 

visible result totaled about 25 minutes in Photosynth, 5 minutes faster than the method 

used in this project. On the other hand, Photosynth requires an internet connection to 

upload the images and then perform SfM. Processing the captured images with 

Photosynth in the field would only be possible with a cell card installed in the 

workstation, which is neither fast nor reliable. Also, the point cloud result Photosynth 

produced was only created from 105 images of the 162 uploaded (65%). Through 

Photosynth’s automated process, it lost over one-third of the image data captured during 

the survey. 123D Catch was unable to process the images due to its limitation of only 70 

images. 
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The total cost of the research project, including equipment already owned 

(workstation, kite) totaled $835. This cost is substantially lower than many research 

groups, response teams, and companies expect to spend when attempting their own 

surveying and 3D data acquisition [2], [8], [21]. Any individual item used in this project 

is able to be upgraded or substituted for another comparable item. A list of cost 

breakdown is shown below. 

 

Table 2 - Project Costs 

Item Description Cost ($) 

Workstation HP Pavilion dv6 500.00 

Camera GoPro Hero 3 Black 250.00 

Aerial platform Performance kite 50.00 

SfM software VisualSfM, Bundler 0.00 

3D software MeshLab 0.00 

Assorted gear String, harness, etc. 5.00 

Transportation Travel to survey AOI 30.00 

  $835.00 

 

 

4.2 Data 
A total of five survey sessions occurred at the AOI over the duration of the thesis 

research project (Figure 1). The final two surveys incorporated the complete refined 

workflow developed during the earlier phases of the project. The final survey presented 

the best weather conditions as well as images results. A total of 320 photographs were 

captured by the GoPro during the final survey. During the aerial capture session the 



59 

 

wireless link between the workstation and camera was maintained and the images were 

able to successfully transfer. Total aerial surveying time did not exceed 40 minutes. 

Additional surveying did not occur due to the completeness of the final image series, but 

performing another survey at that time could have easily occurred. Due to the maintained 

wireless link, the imagery was immediately accessible on the workstation for manual 

integrity review. Out of the 320 photographs captured during the field survey session, 

162 were identified as useable. 

 The estimated average altitude of the kite was around 70 feet, with the maximum 

oblique camera angle calculated to around 40-45°. The extent of the AOI captured by the 

camera in a single image from an altitude of 70 feet is represented in the figure below 

(Figure 24). Majority of the images were captured with angles lower than the maximum 

or nadir. The visible extent of the kite is useful in determining what objects in the scene 

will be better surveyed. Objects closer to the sensor will experience a greater degree of 

perspective change, therefore more easily calculated and recognized by SfM algorithms. 

Especially with more oblique images, the objects above the focal horizon will become 

less useful for SfM calculations due to their minimal perspective movement. 
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Figure 24 - Camera view from 70 feet altitude 

 

With an oblique camera angle of 45° and a kite altitude of 70 feet, the estimated 

useful viewing distance for SfM is less than 100 feet measured from the ground position 

of the sensor, with the field of view limited by the camera lens. The disadvantage of 

oblique imagery can be overcome with additional perspectives from the camera. The 

more angles available to the SfM algorithm, the higher possibility it has to calculate 

feature position within the AOI. 

The data captured and used throughout the thesis project is summarized below 

(Table 3). The foundational data required for the success of the project workflow is the 

aerial imagery. Depending on the camera platform and aerial vehicle used for surveying, 

the quantity and quality of images will differ. In total 162 images of the surveyed AOI 

are used in the 3D reconstruction workflow. The satellite imagery and GIS vector dataset 

are used within a GIS for verifying the data accuracy and integrity. 
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Table 3 - Data Table 

Data type Measurement Source 

Oblique/Nadir aerial photography 100 pictures used 

122 mb total 

5 Megapixel 

 

GoPro Hero 3  

Ground level photos 62 pictures used 

119 mb total 

5-12 Megapixel 

 

GoPro Hero 3 

Cannon Digital 

Nadir aerial/satellite imagery X mb - streamed Google, GeoEye, 

Digital Globe 

 

GIS vector dataset of GMU 

campus 

437 kb GMU GGS 

department 

 

 

4.3 Structure from Motion 
Multiple sessions of workflow processing occurred to test the integrity of the pipeline in 

different settings and with varying datasets. Prior to field application of the refined 

workflow in phase 3 of the project (see Appendix B), test image datasets were used to 

formulate the optimal SfM and 3D reconstruction steps. These steps were refined and 

developed through phase 1 and 2 of the project (see Appendix B). The following section 

summarizes the input data, variables, parameters, and results of the SfM workflow 

performed during the final field test. A detailed procedural workflow of these steps are 

found in chapter 3 and summarized in Appendix A.  

Step A: Within VisualSfM, the 162 selected images from the final survey are loaded into 

the program using “Open Multiple Images”. Loading takes a fraction of a second per 
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image, with the whole image series taking about 3 minutes. The image series is visible as 

a 2D grid within the UI display (Figure 25). 

 

 

Figure 25 - Results: Step A 

 

 

Step B: Once loaded, the images must be analyzed for features and similar matches. This 

step is initialized by pressing the “Compute Missing Matches” button. This step is CPU 

processing heavy and the workstation is not interfered with. In total the SIFT operation 

and matching takes roughly 20 minutes. The result of this step is not immediately visible, 

but the image matching and relationships calculated from the SIFT operation can be 

plotted for visual representation (Figure 26). These graphs display the hierarchal 

relationship between the images (spanning tree) and number of similar features (match 

matrix). 
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Figure 26 - Results: Spanning tree and Match matrix 

 

 

Following this step there were three images identified without significant matching pairs, 

therefore excluded from the graphs and future analyses. Further investigation determined 

that the perspective from the three excluded images was vastly different from the 

remaining group, and the workflow should continue without them. 

Step C: Sparse reconstruction only become available as an option within VisualSfM once 

an image series with computed matches is loaded. This step is initialized by pressing the 

“Compute 3D Reconstruction” button on the toolbar. While the program systematically 

displays the camera perspectives the 3D point cloud progressively grows in complexity 

(Figure 27). During this step the display UI is navigable by the user. 
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Figure 27 - Results: Step C 

 

 

Full sparse cloud reconstruction of all the images takes about 7 minutes. During this step 

three model iterations were built, each one becoming progressively more intricate, 

eventually producing the final sparse point cloud. No additional images were identified as 

poor matches or were unable to be projected into the point cloud. 

Step D: With the sparse point cloud completed, the dense point cloud can then be 

calculated. Dense 3D reconstruction utilizes the CMVS procedure, which is initialized by 

pressing the “Run Dense Reconstruction” button on the toolbar. This step requires 

significant CPU processing as well and should not be interfered with. Once started, the 

dense 3D cloud reconstruction takes about 30 minutes. The final result is viewed in the 

display UI by selecting View > Dense 3D points (Figure 28). 
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Figure 28 - Results: Dense Point Cloud 

 

 

The dense 3D reconstruction step simultaneously creates a unique working folder for the 

dense point cloud model. Within the folder are the three main files that are used in the 

following step: bundle.rd.out, list.txt and model_1.ply. The remaining steps are performed 

in MeshLab. 

 

4.4 3D Reconstruction 
Step E and F: These two steps are very brief and involve similar procedures to 

accomplish. In MeshLab the bundle.rd.out project is opened by selecting “Open Project” 

and navigating to the saved directory. After the project file is selected the camera file is 

requested, which is the list.txt file inside the bundle.rd.out project. At this time all images 

used to produce the point cloud and the sparse point cloud are present in the MeshLab 
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display. Without manipulating anything, the point cloud mesh is deleted. The dense point 

cloud replaces the sparse point cloud by going to File > Import Mesh, and selecting the 

named .ply file, in this case “model_1.ply” (Figure 29). These steps take less than 1 

minute in total. The imported dense point cloud then must be cleaned for proper Poisson 

reconstruction execution. 

 

 

Figure 29 - Results: Dense Point Cloud 2 

 

 

Step G: Cleaning the erroneous points in the dense point cloud is simple but potentially 

flawed due to user interpretation. Extra care is taken to ensure the overall point cloud 

integrity is maintained while the loose points are removed from the dataset. This step 

takes around 5 minutes to complete. 

Steps H and I: Poisson’s surface reconstruction is a particular procedure, yet is 

considered one of the best point-to-surface reconstruction algorithms in computer vision. 
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Numerous iterations of the algorithm were applied using varying parameters. The ideal 

Poisson mesh for this instance was created using octree depth – 7, solver divide – 6, and 

the remaining values of 1. The resulting mesh is relatively accurate compared to the point 

cloud (Figure 30). 

 

 

Figure 30 - Results: Steps H, I 

 

 

With a satisfactory Poisson mesh layer, further cleaning commences to better represent 

the surveyed AOI (Step I). Using similar selection and removing techniques as with the 

erroneous vertices in the point cloud, the improper mesh faces are deleted from the 

model. This portion of the step is dependent on the user familiarity with the scene and 

amount of discretion used to delete or retain areas of the AOI. Non-manifold edges were 

removed using the select features process described above. The 3D model is then 

prepared for texture application (Figure 30). Producing the preferred Poisson 3D surface 

model and cleaning the mesh totaled around 5 minutes. 
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Step J: Using MeshLab is advantageous for applying image textures to models because 

the imported project from VisualSfM has the camera angles and rasters included with the 

point cloud. With the cleaned 3D scene model ready, the corresponding images are 

parameterized against the 3D mesh, recalculating the optimal image to use for each face 

of the mesh. Two separate texture files were created with different pixel size values: 1024 

and 2048. The 1024 pixels size produced acceptable texture results with slight blurring 

and lack of detail, taking less than a minute to process (Figure 31). The 2048 pixel size 

produced incredibly detailed textures with spatial resolution equal to the input images, 

taking about 4 minutes to process (Figure 31). Depending on the speed and quality of the 

desired texture, this step is variable. For the final model texture, the 2048 pixel size 

texture layer was used (Figure 23). 

 

 

Figure 31 - Step J: Textures 
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Step K: The 3D reconstructed model completed via SfM from aerial imagery is then 

prepared for analysis and application (Figure 23). The textured models in MeshLab must 

be exported as the desired file type. In order to ensure the texture is included with the 3D 

model it is exported as a “.ply” file. This 3D file type is very common and is accessible 

by almost all 3D rendering and GIS platforms. 

 

4.5 Accuracy Comparison 
This section of the chapter compares the relative accuracy of the produced 3D dataset 

from the thesis workflow against other available data, a CAD dataset with building 

footprints of GMU campus. The relative applicability of this thesis workflow is also 

compared against the uses for 3D reconstructed scenes within other relevant fields.  

In order to test the accuracy of the output datasets, the 3D sparse point cloud and final 

texture model are compared with CAD building footprints within a GIS. The 3D datasets 

created in MeshLab have the ability to be geospatially rectified by using the reference 

tool. Providing four real-world coordinates as control points, the models are able to be 

adjusted to match coordinate systems (Figure 32). Once the 3D model datasets are scaled 

and rectified using four control points, the RMS errors of the models are under 0.2 

meters. It is possible to add more control points and receive a more accurate 

transformation, but more precise control points need to be determined. 
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Figure 32 - Georeferencing Model 

 

 

Overlaying the 3D sparse point cloud and the final 3D texture model onto GMU building 

footprint shapefile in GIS produces promising accuracy results. The overall distortion 

experienced by the model according to the input ground control points is under 0.2 

meters. This value is relatively low by survey standards and could be improved even 

more. The input control points were estimations taken from satellite imagery on Google 

Maps, which has a stated horizontal accuracy of up to 6.1 meters. These values could be 

vastly improved by using precision GPS or theodolite surveying equipment. Assessing 

the relative accuracy of the output 3D models is performed after geospatial rectification. 

Due to the SIFT algorithms performed during SfM, each image is precisely placed in 

relative space to each other [41]. These equations ensure that provided undistorted 

imagery, the relative position of objects and features within the image series are exactly 

precise, only limited by the pixel resolution of the input images. This precise quality is 

present in the 3D models produced. Measuring relatively, the models present excellent 
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accuracy, down to the relative size of bricks and even space between window blinds 

(Figure 31). The 3D sparse point cloud also provides incredibly accurate measurements 

of the identified significant features, such as building edges, corners, and light objects. 

Even if the 3D models were unable to be geospatially rectified, knowing the 

measurement of a single feature within the scene could provide a scale to establish 

relative dimensions for the entire scene.  

Four datasets are produced from the thesis workflow that can be used in research 

and application: image series of AOI, sparse 3D point cloud, digital elevation model 

(DEM), and final 3D model. Each dataset has potential applications within related fields 

of research and industry.  

 

Table 4 - Output datasets 

Dataset Format Process time 

Aerial survey image series JPG, TIF, PNG Instantly during or immediately 

following survey 

 

Sparse 3D point cloud PLY, OBJ 10-30 minutes following survey 

depending on image count 

 

Digital elevation model Raster formats 10-30 minutes following survey 

depending on image count 

 

Final textured 3D model PLY, OBJ 30-80 minutes following survey 

depending on image count 

   

 

 

The image series captured during the survey is immediately available for review. Having 

an aerial view of a scene can provide near real-time information and data about a 
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situation. Also, having aerial imagery offers perspectives that are otherwise not possible 

from ground vantage points. In addition to immediate viewing, aerial imagery can be 

overlain on topographic maps and elevation data to enhance spatial detail. The sparse 3D 

point cloud created in step C quickly delivers (10-30 min) a partial 3D representation of 

the AOI that can be interpreted by analysts. Having a generalized representation of a 

scene can be almost as useful as a full model when an area only has to be simply mapped. 

Most 3D sparse point clouds produced from SfM have identified all the significant 

features and object within each image and interpreted that information into the vertices. 

Even with minimal spatial training users and analysts alike can deduce the objects within 

a 3D sparse point cloud. For a geospatial data production pipeline, the 3D sparse point 

cloud provides more than adequate detail about features in the AOI for geospatial units to 

be extracted. For instance, the extent and edges of the Green Acres building surveyed in 

this project were thoroughly visible within the sparse point cloud (Figure 13). An analyst 

could easily capture a representative building polygon or create an accurate 3D building 

model based on the point cloud information. Although not produced within the presented 

workflow, a DEM can easily be extrapolated from both the sparse or dense 3D point 

clouds. DEMs are commonly used as the topographic foundation for areas of interest and 

provide precise elevation information about ground and surface features. An accurate 

DEM can be produced within MeshLab after additional cleaning by exporting either the 

point cloud layer or 3D Poisson surface as compatible raster layer or 3D polygon file 

types. The final textured 3D model produced by the thesis workflow delivers a complete 

product for visual modeling and spatial analysis. The model incorporates high-resolution 
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imagery from the aerial survey, spatial accuracy and framework from the SfM point 

clouds, and visual cohesiveness of Poisson’s mesh to create a final scene ready for 

application. 

4.6 Concept Applications 
The final results from the thesis workflow have the potential for application within many 

fields. Once integrated with additional geospatial data, such as building shapefiles, and 

incorporated into a GIS or other spatial analyses platform, the possible uses are only 

limited by the user (Figure 32). The degree of usefulness of the four geospatial datasets 

produced by this workflow depends on the field application. One or all of the output 

datasets from the workflow can be used in elements of each of the following fields: 

military operations, emergency response, humanitarian aid, topographic survey, and 

cultural heritage. The incorporation of the presented workflow in this thesis would 

assume the needs of the user require optimal 3D geospatial results while incurring 

minimal cost and training while having no internet access. 

One of the most important requirements of geospatial data used for military 

operations is accuracy. Having precise and current information is paramount to all other 

factors of data [3], [31]. Secondary to data accuracy is the speed of data acquisition to 

analysis. Time-critical applications of geospatial information such as real-time tactical 

operations require cutting-edge technology far superior to anything available to the public 

[15]. Using the workflow presented in this project would produce products for much less 

time-sensitive scenarios. Having a broad imagery overview of an AOI or sparse point 

cloud provides geospatial information about a region that could otherwise be difficult to 
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infer from ground position. DEMs would provide relatively accurate elevation datasets, 

able to supplement movement operations and base camp set up. 

Emergency response situations require rapid planning in situations where 3D data 

is not readily available. Some departments have incorporated aerial survey systems that 

provide real-time video feed of an AOI [8]. Attempts to advance this technology further 

into the realm of producing 3D datasets in an affordable manner have been researched 

[8]. Three primary factors needed for emergency response data acquisition are overall 

AOI spatial awareness, processing speed, and cost. Having knowledge of the scene is 

crucial for emergency responders. Without proper information the lives of those in 

danger as well as the responders are in jeopardy. The near-instant aerial imagery provided 

by this method would allow immediate visual review and improve situational response. 

Alternative aerial viewing angles of the AOI would broaden the scope of the emergency 

environment. Using the sparse 3D point cloud would elucidate structure or scene 

obstacles and allow them to be quickly modeled or analyzed. The textured 3D model 

might not be available for immediate use with emergency response, but could be 

incorporated into planning phases of emergency situations, such as wild fires [8]. Another 

significant factor for acquiring 3D geospatial data is the cost. Many emergency response 

units do not have overhead funding to acquire the equipment or datasets for 3D AOI 

models. For this reason, using an affordable workflow to acquire 3D geospatial data is 

ideal [8]. 

Humanitarian aid operations are large, complex orchestrations usually performed 

by non-profit organizations in regions of the world where modern technologies are not 
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readily available. In the instances of the earthquake in Haiti (2010) and Fukushima, Japan 

(2011), certain commercial satellite imagery companies offered continual and frequent 

imagery updates for the regions under duress under the International Charter on Space 

and Major Disasters (www.disasterscharter.org). Even though satellite imagery is 

incredibly useful for high-level scene awareness, it does not provide detail about many 

ground structures or features. The lack of commercial-grade surveying equipment, or 

funding to acquire the equipment or 3D data, provide an ideal situation to apply this 

demonstrated workflow. Regions requiring humanitarian aid can experience a range of 

situations, such as natural disasters, drought or famine, and contagious diseases. Each of 

these scenarios requires geospatial information about the AOI. Aerial imagery would give 

aid workers an overview of the environmental situation or extent of damage in areas that 

are otherwise unable to be traversed on foot. Stitching the images together to create 

reference maps can aide with documenting evolving landscapes, such as refugee camps 

[50], [52]. Sparse 3D point clouds would model the scene in such a way that aid workers 

could quickly gain spatial awareness of objects within the AOI. The point cloud could 

also be used for quick 3D feature extraction, presenting a modeled recreation of the AOI. 

Using the sparse point cloud or a DEM from the geospatial data could significantly aid in 

determining locations for temporary aid camps or bivouacs. DEMs also offer data 

potentially used for identifying aerial med-evac or helipad operations. The textured 3D 

model could be used for wholesome environment representation. This model can be used 

for training, educating, and planning for aid workers as well as victims within the 

affected area. The affordability and accessibility of this workflow strongly adheres to the 
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confines within which humanitarian organizations are able to function. This workflow 

could be implemented in almost any situation worldwide with minimal funding and 

limited training. 

Topographic surveys traditionally use planes or helicopters with LiDAR 

capabilities to produce large-scale geospatial datasets of regions. As cities and 

environments evolve, the subtle changes need to be documented. Ordering or performing 

frequent large-scale aerial LiDAR surveys is incredibly expensive and requires 

substantial equipment and training. Being able to perform a localized aerial survey with 

3D data results comparable to LiDAR is very useful for topographic surveys [18], [17]. 

The research studies performed by Tonkin and Azmi reveal an ongoing interest in 

developing affordable and accessible methods of aerial surveying and production of 3D 

geospatial data. DEMs are foundational datasets used to create topographic surveys. 

Using the elevation data, maps and digital feature datasets are able to be accurately 

georectified and updated with current positioning. Topographic surveys rely on 

periodically updating their subject information. Using the 3D point clouds or texture 

model would supplement feature placement or alteration. The frequency of updating or 

modifying topographic surveys can be financially taxing [17]. The use of this workflow 

would greatly reduce the upkeep cost of continual aerial surveys. 

Cultural heritage fields have a tendency to hold onto the past. Only recently have 

many research institutions involved with cultural heritage and archaeology adopted using 

digital means to document, record, and survey [58], [59]. Although the incorporation of 

modern technologies within cultural heritage has flourished in the past few years, many 
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groups are still pushing the limitations of cost and accessibility. The use of low-cost and 

accessible equipment for aerial surveying and acquisition of 3D geospatial data is a 

growing pursuit within cultural heritage [21], [22], [24]. Using aerial imagery has been a 

foundational aspect of archaeological excavations. The aerial perspective broadens the 

overall understanding of features and their relationships. The images can be stitched 

together to create an overview map which can be used for planning and education [50]. 

The sparse 3D point cloud is a rapid solution for giving relative spatial placement of 

features such as architectural ruins, burial sites, and historical landmarks. Additional 

features can be extrapolated from the sparse point cloud to create a 3D digital model for 

increased visibility. At the same time, the final texture model would provide a complete 

rendering of an object or AOI which can be used for planning, education, and 

publication. Cultural heritage foundations or research groups usually do not have 

guaranteed funding or overhead for expensive technologies. Using this workflow would 

offer an affordable solution to acquiring the much desired 3D geospatial data. Being 

accessible and customizable, the workflow can be altered to best suit individual 

parameters. 
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CHAPTER FIVE: CONCLUSION & FUTURE RESEARCH 

The process and applications of this thesis research present exciting opportunities for 

using low-cost and accessible aerial imagery platforms to create original 3D datasets. The 

relative ease of using simple aerial vehicles, cameras, and open source software suggest 

the thesis pipeline as a viable method for rapid 3D reconstruction. Reviewing the current 

literature and research journals reveals that the aerial imagery-SfM-3D reconstruction 

workflow is a highly desired method, and is pursued within the fields of computer vision, 

cultural heritage, topographic survey, emergency response, military intelligence, and 

more. Utilizing this thesis workflow can greatly contribute to research applications 

searching for accessible, affordable, and straight-forward methods for rapid 3D 

reconstruction from imagery, especially from aerial platforms. 

The method of aerial imagery capture presented in this project is supplied as an 

affordable and easy-to-use solution that is widely accepted worldwide. Kites and balloons 

are traditionally viewed as innocuous or even friendly symbols [50]. Drones and UAVs 

are incredibly useful pieces of technology for aerial remote sensing, but often endure 

resistance due to their publicized use with military applications [60]. Only within the past 

few years have UAVs become viable as tools for private research and application [3]. 

Cutting-edge drone technology capable of remote sensing still remains prohibitive in 

terms of price and required piloting skill set. As remote-controlled and automated aerial 
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platforms continue to become more affordable and navigable, they will proliferate in use 

worldwide. 

The resurgence of SfM as a means for 3D reconstruction available publicly for 

virtual tourism (Photosynth) and research (VisualSfM, Bundler) beckons to its simplicity 

and accessibility as a tool. Providing an affordable and accessible solution for 3D 

reconstruction is rapidly growing in public demand [2], [8], [21], [28]. Highly advanced 

systems of 3D reconstruction such as LiDAR involve sophisticated hardware, software, 

and vehicles to produce datasets. Even though LiDAR datasets are considered the optimal 

industry standard for 3D scene collection, they have severe limitations due to being 

expensive and technically challenging to capture and manage [18]. Until LiDAR becomes 

more accessible to general-use customers or easily captured without expensive 

equipment, SfM is widely used as a comparable solution. 

There are a number of best practices to consider based on the results from this 

study, relating to aerial imagery quality, workflow stability, and 3D data integrity. For 

aerial image quality, it is necessary to use a vehicle that is reliable and will behave in a 

predictable manner when piloted. Most research performed through academia and citizen 

science regarding aerial kite imagery conclude that the delta shaped kite design provides 

the optimal lift and directional control for best results [50], [52]. The dual-line available 

with the sport kite used in this project provided additional control of the vehicle while 

reducing the stability of the platform. This result suggests that given equal weather 

conditions, a more stable kite could benefit the workflow by producing clear imagery due 

to less rapid movement. For the camera, there is no consensus on what device is optimal, 
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as the purpose for different cameras differs with the usage. The GoPro has been a 

common tool for many kite imaging enthusiasts as well as commercial UAV producers, 

due to it being high quality, lightweight, and equipped with numerous capturing features 

[50], [61], [62]. Most images captured are able to be processed by SfM algorithms as 

long as the image series adheres to the proper capture method (see section 3.2.3). Natural 

and man-made objects that appear in images such as buildings and vegetation can equally 

be identified within SIFT. There are features that present difficulties for aerial imagery 

capture, SfM algorithms, and 3D modeling, which should be avoided. Moving, reflective, 

thin, or amorphous features, such as water, clouds, mirrors, power lines, or bare tree 

branches are considered anomalies and will usually cause substantial errors within SfM, 

which subsequently misleads 3D reconstruction. The primary open source software used 

in this project (VisualSfM, MeshLab) were chosen due to their broad support and 

appearance in related scientific journals. Other similar open source software platforms 

that are used are Bundler and Blender, for SfM and 3D modeling, respectively. 

Throughout all the literature reviewed no single software platform mentioned above was 

clearly revealed as superior. In fact, most articles that chose to use one platform, such as 

Bundler, often mentioned the corresponding platform (VisualSfM) as a viable and 

respected option. The best practice solutions for an open source software SfM to 3D 

model pipeline are the four platforms mentioned: VisualSfM, Bundler, MeshLab, and 

Blender. For ideal 3D data results and accuracy integrity it is best to have proper ground 

control and scene measurements. Unless relative measurements or exact coordinates are 

known, any survey performed risks the 3D data being misleading. Best practice for 
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survey accuracy is to perform research or capture precise ground control coordinates. 

Additional research must be performed to test the workflow in various field survey 

conditions. According to the conclusions from this project, open fields with limited visual 

obstructions provide optimal results. Kite aerial imagery communities suggest that most 

locations are able to be surveyed as long as terrain provides enough room for takeoff and 

landing, vertical obstructions are limited, and weather conditions are favorable [50].  

 

Future Research 

The workflow executed in this thesis proved a working demonstration of rapidly creating 

3D geospatial data from aerial imagery using open source SfM. Future research regarding 

this thesis project will focus around potential improvements and alternative equipment or 

methods. In this section alternative options for equipment and software improvement and 

survey location testing are discussed, as well as future implications for aerial surveying. 

An ideal camera platform for this project would be a high-resolution device with 

increased capacity to stream live pictures or video feed to a workstation. This camera 

would improve the speed and quality of images used in the following SfM process and 

texture model. In addition, a GPS device with increased elevation reading would 

contribute additional data towards later analysis for positional placement of the data. It 

would also be beneficial to incorporate a small laser range finder onto the aerial platform 

to have distance readings between the platform and observed scene. In addition, using a 

stabilizing device such as a gimbal on the camera would greatly improve stability. 
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Stabilized images would be clearer and more unified which produces higher fidelity SfM 

results and improved optical accuracy. 

GPS devices and precise ground control points would greatly increase the 

accuracy of this workflow. Measuring relatively the results of this project produce 

exceptional data, but with increased geospatial accuracy the 3D data becomes more 

useful. Including a brief step in the workflow for capturing ground coordinates through 

GPS or surveying would provide the necessary information for scene calibration. In 

addition, using a range finder or laser measurements could provide quick benchmarks for 

observer placement. 

A simple alteration to the project workflow is to increase the altitude of the kite. 

A higher altitude would reveal a farther view distance and allow the AOI to be captured 

in fewer images. For the project the kite remained at an altitude ranging between 60 and 

100 feet depending on wind speed. The average height estimated during the project was 

around 70 feet, with the useful observable distance calculated at less than 100 feet away 

from the sensor at ground level with a field of view limited to the size of the camera lens 

(see section 4.2). The FAA regulations state the maximum altitude for an anchored aerial 

vehicle cannot exceed 500 feet. Equipping the kite with 500 feet of string would allow a 

very large field of view to be captured (Figure 33). Estimating the maximum oblique 

angle for the camera at around 45°, a kite altitude of 500 feet could produce images with 

a useable view distance of around 600 to 700 feet. The altitude would detract from the 

camera’s ability to capture detailed images. Being far from the photographed objects 

would also require a very large change in angle of the kite in order to achieve a useable 
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perspective difference between the image series. Depending on the desired use for the 

images or workflow results, having such a large AOI angle could potentially produce 

illuminating area surveys. 

 

 

Figure 33 - 500 ft kite altitude 

 

 

Using innocuous and simple aerial vehicles such as kites and balloons is a suitable 

means to acquire aerial imagery. Piloting a kite for this project was useful for proving the 

workflow demonstration, but more advanced aerial vehicles and methods are available. 

The more advanced an aerial platform becomes, usually expense and operation difficulty 

increase. This is true for UAVs within the $100 to $600 range because they require 

manual piloting and have reduced capabilities. Once the price goes above $600, 

commercial UAVs become highly-tuned with extensive capabilities. The most significant 

technological advancement for these commercial UAVs is the autopilot ability. 
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There are a handful of UAVs that may be considered for integration with this 

research workflow. The combination of reasonable pricing and impressive aerial 

capabilities are promising for these platforms, the 3D IRIS and DJI Phantom. The 3D 

IRIS produced by 3D Robotics (3DR) is a quadcopter with the lift capacity to carry 0.8 

lbs, two-axis gimbal stabilization, built-in carrier for a digital camera, and maintain over 

20 minutes of flight time [62]. These specifications alone meet minimum desired 

requirements for carrying additional camera gear and performing numerous surveys. The 

most significant capability of the 3D IRIS is its 3DR-developed autopilot function which 

allows the UAV to automatically navigate to its given destination. The 3D IRIS is made 

in America and is available for $750. The DJI Phantom produced by DJI is a quadcopter 

with a built-in high-resolution camera, automatic takeoff and landing functions, live 

video feeds from the UAV, and onboard sensors for obstacle detection [61]. Although the 

Phantom does not have autopilot capability for traversing, it still maintains the ability to 

correct itself and refrain from crashing into obstructions. The live video feed and built-in 

camera are maximally integrated to produce precise survey results. The Phantom is 

available for around $900. These aerial systems single-handedly address the limitations 

faced by most UAV imaging methods: being able to adequately survey an area due to 

aerial vehicle mobility, and vehicle navigation precision which is usually severely limited 

by the pilot. Less than seven years ago, UAVs with a fraction of these capabilities and 

precision were very uncommon with pricing around $7,000, which was still considered 

“affordable” by some purchasers [8].  
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It is very possible to use proprietary SfM solutions such as Photosynth and 123D 

Catch within the workflow presented in this thesis. The primary reasons for not using 

them in this research are their limitation on parameter customization, photograph 

restrictions, black-box algorithms, and internet reliance. Within a controlled research 

environment it is entirely possible and encouraged to use all available tools at your 

disposal. The limitations of applying the workflow in the field discouraged the use of 

these packages as possible solutions. For future applications, incorporating Photosynth 

and 123D Catch as potential SfM solutions could improve output integrity and processing 

speed. 

Other locations of interest should be considered for aerial survey. Optimally, 

survey locations focusing on distinct features would allow the thesis methods to be fully 

tested. Surveys sites such as an empty field, clustered buildings, dense vegetation, or 

rough terrain would all present unique circumstances for the workflow to attempt. For 

some of these environments the use of navigable aerial platforms or UAVs would likely 

have to be used. 

When it comes to SfM the most limiting factor is processing time. Using the 

standard incremental reconstruction SfM method has the limitations of loops and 

initializations, which create a geometric increase in processing time. Incremental 

reconstruction is necessary when image series are seemingly random or do not have 

predefined relationships established. Using the workstation in this project, performing 

SfM took about 3 minutes for 40 photos, and 20 minutes for 160 images. This 

progression of processing time portrays the geometric processing time required by using 
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incremental reconstruction. Optimal solutions would be to use powerful processors or 

even cloud computing services to calculate the SfM results. Powerful processers are more 

expensive and cloud computing requires at least a temporary internet connection. 

Monetary expense and internet reliability are both intentionally avoided in this project to 

prove an affordable and accessible workflow concept. One solution that can be integrated 

into the current workflow is the use of linear SfM processing [39]. Linear SfM processing 

implies that the image series was captured in sequential order, therefore assuming that 

each image is adjacent to the next. The linear SfM algorithm significantly reduces 

processing time due to each image only being compared to the implied nearest neighbors, 

effectively increasing time for each added image by a constant, linear amount. 

An interesting element to research and apply to this workflow is a crowd-sourced 

approach [63]. The advantage of SfM is its ability to aggregate images from multiple 

camera sources with different parameters or even images captured at varying times and 

conditions. This strength of SfM would play well into attempting a crowd-sourced 

approach to the workflow. Multiple aerial vehicles and ground units could simultaneously 

capture images of the AOI and place them in a single repository. VisualSfM would be 

capable of managing the image series and potentially utilizing a majority of the images to 

produce the point cloud result. A crowd-sourced approach could greatly increase the 

speed of survey imagery capture and variety of AOI perspectives, resulting in a higher 

fidelity point cloud and 3D model. Crowd sourcing would also allow image contributions 

to be added to the image series at different times. With each subsequent or additional 

crowd-sourced survey, the image series would grow in complexity and detail. In a similar 
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manner using multiple cameras either on the aerial vehicle or with multiple vehicles 

would significantly improve overall coverage and potential images for the AOI. Further 

research would be performed to determine the proper distributed system upon which the 

crowd-sourced method would depend. 

Another interesting element related to the use of SfM comes from the approach 

that 123D Catch advertises. AutoCAD’s SfM software is advertised as a solution for 

digitally capturing objects and using their software pipeline to produce 3D models from a 

3D printer. 3D printers have only recently become available for public use within the past 

few years, previously only available with industrial applications. These devices offer 

novel and practical solutions for creating plastic recreations of objects. Using the 3D 

model results from this workflow, miniature models of the surveyed AOI could be 

produced using 3D printers. Having a tangible recreation of a surveyed area enhances the 

perception and information communicated. With a complete workflow in place along 

with a 3D printer, it would be possible to survey, process, and produce a 3D physical 

model of an AOI within hours of initiation. 

Perhaps the most significant issue surrounding this research and related fields is 

increased public awareness of aerial vehicles such as UAVs and their impacts on safety 

and privacy. The introduction of UAVs as serious surveillance and weapon delivery 

systems emerged during the first Gulf War, according to a Department of the Navy report 

in 1991. Military or government agency functions for UAVs were proprietary until recent 

adaptations of UAVs became available for public use. The legality of recreational and 

professional UAVs is currently under debate by the FAA [66]. The ruling from the FAA 
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could either expand or cripple the use of UAVs in the public domain. The current FAA 

regulations concerning UAVs do not address the issues of privacy or surveillance, as long 

as the vehicle is used for the intended recreational purpose. Drones may not be used for 

commercial purposes. Consequently, a common public perception of UAVs is drawn 

from the military aspect instead of the research and utility potential UAVs have. This 

perception along with the increased public awareness of developing privacy concerns has 

caused an uncharted realm for legal and public debate over UAVs. The growth of the 

internet in the past few decades produced debates and concepts of privacy and individual 

rights that were never previously imagined in legal terms. Especially with the 

proliferation of social media and mobile sensors, an individual’s location and information 

privacy are almost nonexistent. Surprisingly, most people do not even realize they are 

usually broadcasting such private information [64]. This fact causes companies and 

legislatures to consider whether or not the legality of location-based information is 

considered private depending if you are in a private or public location. Projects such as 

Google Street View are ground-breaking in their ingenuity and ability to capture 

geospatial data. Very soon after its inception and public reveal, Google was under fire for 

potentially violating the privacy of every location and person the project mapped. 

Although Google legally acquired all Street View imagery and is allowed to publically 

display it online, many people still believe their privacy is violated. During some of the 

Street View project, Google “casually” acquired wifi signals, emails, and passwords of 

nearby homes, resulting in a legal suit presented by 38 US states and a fine of 7 million 

dollars [65]. With Google and many technologies pushing the limits of public and private 
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data, it is not surprising when the concept of highly-mobile aerial vehicles (with a marred 

history of military affiliation) equipped with cameras or other sensors being abundant are 

questioned. With the future of UAVs being uncertain, using more acceptable aerial 

vehicles such as kites and balloons would rarely cause vitriol or concern for privacy or 

safety. 
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APPENDIX A 

Complex workflow 
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APPENDIX B 

Project Schedule 
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